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Getting Started 

What can I do with Voice Announcement Manager? 

Voice Announcement Manager is a stand-alone application that lets you copy audio files 
and announcement properties from the Voice Announcement Manager computer to a 
voice system or back.  

Basic Features 

Voice Announcement Manager offers the following basic features:  

 Simplified administration to add, change, and remove Communication Manager 
announcement information. 

 The ability to back up and restore announcement information. 

 The ability to view the status of announcement on your voice system’s new VAL boards 
(TN2501AP). 

 The ability to support virtual VAL boards for the Avaya G350 Media Gateway, the Avaya 
G700 Media Gateway in the Avaya S8700 Media Server configuration, and the Avaya 
G700 Media Gateway in the Avaya S8300 Media Server configuration. 

Voice Announcement Manager allows you to see how many announcements are 
associated with a given voice system or VAL/virtual VAL board (a.k.a., circuit pack), the 
names of your voice systems and their VAL/virtual VAL board locations, the names of 
audio files on the computer and on the VAL/virtual VAL boards, and the announcement 
properties (that is, the values of the Communication Manager fields named Filename, 
Repeating, Extension, Location, COR, TN, Queue, Protected, Rate, Length, Size, 
Timestamp, and On Board). Voice Announcement Manager also offers a History Log that 
lists Voice Announcement Manager status. 

Understanding Announcements with Voice Announcement Manager 

With your new VAL/virtual VAL board, "announcements" have two parts: 

 an audio file – stored on a VAL/virtual VAL board and/or on the Voice Announcement 
Manager computer 

 announcement properties – stored on a voice system and/or on the Voice 
Announcement Manager computer. 

Everything you do in Voice Announcement Manager requires that you understand this 
two-part concept. 
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What's New in this Release 

Voice Announcement Manager Release 3.1 introduces the following enhancements: 

 Support for the S8400 server. 

 Support for the S8720 server. 

 Support for the G250-DCP media gateway. 

 Support for the G250-DS1 media gateway. 

 Support of SCP for secure file transfer. 
 
NOTE: 
The G700 media gateway does not support SCP. 

 The ability to place your audio groups into folders.  

 The ability to export specific announcement properties. 

 The ability to move specific announcement properties from one source to another 
source.  

 The ability to move multiple audio files at a time. 

 The ability to find and replace a VAL source within audio groups in a voice system. 

 The ability for non-administrative Windows users to access and use Avaya Voice 
Announcement Manager. 

 The ability for users to change the language of the text displayed in Avaya Voice 
Announcement Manager. All of the text strings that appear in Avaya Voice 
Announcement Manager are now contained in an external file. You can access these 
text strings from the Properties (or resource) file. The default text strings are provided in 
U.S. English. If you have a Properties file that has been translated for your locale and 
language, Avaya Voice Announcement Manager will use that file and display the text 
strings from that file in your language. The Properties file is located in the Resources 
folder and is named VAM_<language>_<locale>.properties. 

For more information on these enhancements, and late-breaking product information, see 
the Voice Announcement Manager readme file. 

Previous Enhancements 

Voice Announcement Manager Release 3.0 

Voice Announcement Manager Release 3.0 introduced the following enhancements: 

 Support for the S8500B server. 

 Support for the S8710 server. 

 Support for the G250 media gateway. 

 Support for the G250 BRI media gateway. 

 Support for SFTP communication with TN2501 boards. 

 The ability to specify the maximum number of minutes that you want Voice 
Announcement Manager to maintain its connection to the voice system 

 The ability to specify the timeout interval for which you want Voice Announcement 
Manager to try connecting to the voice system.  

 The ability to create, view, and manage audio groups. 

 Support for locally sourced Music. 

 Easier movement of announcement properties from one source to another. 
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 The ability to record an announcement to an extension and then broadcast that WAV 
file to an audio group (Broadcast by Extension) or to any other extension (Broadcast to 
Extension). 

Voice Announcement Manager Release 2.1 

Voice Announcement Manager Release 2.1 introduced the following enhancements: 

 The ability to rename audio files. 

 The ability to rename announcement properties. 

 The ability to schedule import tasks. 

 The ability to schedule export tasks. 

 The ability to start a user-specified audio player/editor application from Voice 
Announcement Manager. 

 Use of a standard encryption algorithm for password encryption. 

 Use of SSH2 

 Automatic and secure authentication of both ends of the connection. Both the 
server and the client are authenticated to prevent identity spoofing.  

 Secure terminal sessions utilizing strong encryption.  

 Connection to a Linux-based voice system on port 5022.  

 Support for Microsoft Windows Server 2003, Microsoft Windows Small Business Server 
2003, and Microsoft Windows Storage Server 2003.  

Voice Announcement Manager Release 2.0 

Voice Announcement Manager Release 2.0 introduced the following enhancements: 

 The ability to support G350 virtual VAL boards. 

 The ability to support the S8500 Media Server with both TN2501AP and G700 Media 
Gateway announcement sources. 

 The ability to search for announcement properties and audio files on a voice system. 

 The ability to import announcement properties from a comma-separated values (CSV) 
file.  

 The ability to export announcement properties to a comma-separated values (CSV) file.  

 The ability to print announcement properties and audio files.  

 The ability to view up to five Announcement Properties windows at once.  

 FTP moves will be blocked if the audio filename length is greater than 27 characters.  

 A persistent status pane.  

 A warning will be displayed if Scheduled Tasks exist when you exit Voice 
Announcement Manager.  

 The ability to configure the Voice Announcement property file from the Voice 
Announcement Manager window. 

 Support for Windows XP.  
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VAL Manager Release 1.3 

VAL Manager Release 1.3 introduced the following enhancements: 

 The ability to support 260 boards (250 virtual VAL boards and 10 VAL boards) for 
Avaya G700 Media Gateway in the Avaya S8700 Media Server configuration. 

 The ability to support 50 virtual VAL boards for Avaya G700 Media Gateway in the 
Avaya S8300 Media Server configuration. 

 The ability to move announcement files from one VAL board to another on the same 
voice system.  

 The ability to move an announcement property file from one VAL board to another on 
the same voice system.  

 The ability to broadcast announcement files onto VAL boards from various voice 
systems.  

 The ability to back up selected VAL/virtual VAL boards on a voice system.  

 The ability to restore selected VAL/virtual VAL boards on a voice system.  

 A Task Editor, which enables you to create and schedule backup and broadcast tasks. 
You can schedule these tasks to run on a specified date and time or at a selected 
frequency (for example, daily, weekly, or monthly). 

 The ability to notify users via email about the outcome of scheduled tasks. 

 A Template Editor, which enables you to create templates of tasks you want to perform 
regularly (such as a backup task). 

 A property file that allows you to configure the following settings: 

 The file size for the status logs. Use the VAL.logLimit=x property (where x is the 
maximum number of MB for the status logs) in the VALProp file to set the file size 
for the status logs. By default, the file size for the status logs is 5 MB. 

 The maximum number of threads spawned per voice system at a time. The threads 
perform FTP operation on a VAL board. By default, the value for this property will 
be 10. 

 The FTP mode (ACTIVE or PASSIVE). 

 Improved logging, with messages being stored for two weeks. The messages will be 
logged in the file val_status.txt. If the file size reaches the limit you set in the 
VAL.logLimit property, the file val_status.txt will be copied to the file 
val_status.txt.old, and Voice Announcement Manager will start logging messages in 
the new val_status.txt file. If the file val_status.txt.old already exists, that file will be 
overwritten. 

NOTE: 
In VAL Manager Release 1.3, Microsoft Windows 98 and Microsoft Windows NT are not 
supported. 

For more information on these enhancements, and late-breaking product information, see 
the Voice Announcement Manager readme file. 
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VAL Manager Release 1.2 

VAL Manager Release 1.2 introduced the following enhancements: 

 This release offers support for Avaya G700 Media Gateway in the Avaya S8300 Media 
Server configuration and the Avaya S8700 Media Server configuration. 

 In the VAL Manager main window, if you right-click a voice system and that voice 
system supports Avaya G700 Media Gateways, then a new pop-up menu option 
appears called "View Status." Selecting this option displays, for each virtual VAL board 
(that is, G700 Media Gateways), whether it is enabled for announcements or disabled 
for announcements.  

 In the above situation, if you right-click a virtual VAL board, VAL Manager displays two 
new pop-up menu options, "Enable" and "Disable." These options appear only for G700 
Media Gateways. 

VAL Manager Release 1.1 

VAL Manager Release 1.1 introduced the following enhancements: 

 This release allows you to launch VAL Manager using a web browser 

 This release adds a new Toolbar 

 This release adds keyboard shortcuts 

 When you start VAL Manager for the first time, this release does not require that you 
add voice systems immediately.  

 When you add a voice system to VAL Manager, this release of VAL Manager does not 
connect to the voice system until you tell it to. 

 This release allows you to specify whether VAL Manager should connect to a given 
voice system on startup. 

 This release allows you to double-click a board to see announcement properties for that 
board. 

 This release accepts 7-digit extensions. 

 In this release, the status bar is at the bottom of the VAL Manager window. 
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Where do I begin? 

To understand how to set up and use Voice Announcement Manager, we recommend 
that you read Voice Announcement Manager’s online help topics in the following order. 
You can see these topics if you click the "Table of Contents" tab (left-most) in the online 
help window. 

 

1 Set up Voice Announcement Manager by reading the online help booklet called, 
"Configuring Voice Announcement Manager." Read the topics in the order that they 
appear in the booklet. 

2 To use Voice Announcement Manager, open the booklet called "Using Voice 
Announcement Manager" and double-click the help topic corresponding to the activity 
that you want to perform. 

Understanding the Voice Announcement Manager main window 

The following is an example of the Voice Announcement Manager main window. 
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Configuring Voice Announcement Manager 

Configuration Overview 

The first time you start Voice Announcement Manager, it automatically displays a dialog 
box into which you can enter the information that Voice Announcement Manager needs 
so it can connect to a supported voice system. 

You can enter the information immediately or cancel the dialog box and enter the 
information later.  However, Voice Announcement Manager functionality is greatly 
diminished until you enter the connectivity information. 

We recommend that you set up Voice Announcement Manager in the following order: 

1 Prepare Communication Manager software for use with Voice Announcement 
Manager. 

2 Start Voice Announcement Manager and enter voice system information into the 
dialog box that automatically appears (the first time you start Voice Announcement 
Manager). 

3 Test connectivity. 

4 Troubleshoot any problems. 

If problems occur, there is usually a Help button on the error message that appears. Click 
the Help button for troubleshooting ideas.  

Preparing Communication Manager software for Voice Announcement 
Manager 

Voice Announcement Manager will not work with the Communication Manager software 
on your voice system until you have properly prepared the Communication Manager 
software for use with Voice Announcement Manager. Specifically, you must set up your 
Communication Manager software with the new VAL boards (G700, G350, and 
TN2501AP) as well as set up the Communication Manager software so you can access it 
over your LAN/WAN via a C-LAN board. 

To prepare your Communication Manager software for Voice Announcement Manager, 
perform the following steps: 

1 Install voice systems, if you have not already. 

 Refer to MCC on the following website: http://made-easy.avaya.com/ 

2 Install C-LAN circuit pack(s).  

 Refer to Administration for Network Connectivity for Avaya Communication Manager 
Software. A copy of this document is available on the Avaya Integrated Management 
Software CD. Optionally, you can search for it as described in Contacting Us for 
Documentation. 

3 Test C-LAN connectivity to the LAN.  

 Refer to Administration for Network Connectivity for Avaya Communication Manager 
Software. A copy of this document is available on the Avaya Integrated Management 
Software CD. Optionally, you can search for it as described in Contacting Us for 
Documentation. 

4 Install VAL circuit pack(s). 

 Refer to the "Non-volatile storage of announcements on VAL" in the chapter 
"Managing Announcements" in the Administrator’s Guide for Avaya Communication 
Manager Software, 555-233-506. A copy of this document is available on the Avaya 
Integrated Management Software CD. Optionally, you can search for it as described 
in Contacting Us for Documentation. 

http://made-easy.avaya.com/
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5 If you want to use Access Security Gateway (ASG), have Avaya enable it on your 
voice systems. 

6 If you want Voice Announcement Manager to have a separate login to your voice 
system (so you can track Voice Announcement Manager activities using the 
Communication Manager History Log), then create a login for that purpose for each 
voice system. 

 

Entering and changing voice system information 

The first time you run Voice Announcement Manager, the Select Option dialog box 
appears. Clicking the Yes button will display the Register Voice System dialog box. In 
this dialog box, enter the connection information for each voice system you want Voice 
Announcement Manager to support, and click OK. 

 To add another voice system, choose System>Register Voice System.    

 To view or change the settings for a voice system you have already added to Voice 
Announcement Manager, right-click on a voice system in the Voice Announcement 
Manager tree and choose Edit Properties. 

Voice Announcement Manager will then display the Edit Voice System Properties dialog 
box.   

Entering and changing voice system information 

The first time you run Voice Announcement Manager, the Select Option dialog box 
appears. Clicking the Yes button will display the Register Voice System dialog box. In 
this dialog box, enter the connection information for each voice system you want Voice 
Announcement Manager to support, and click OK. 

 To add another voice system, choose System>Register Voice System.    

 To view or change the settings for a voice system you have already added to Voice 
Announcement Manager, right-click on a voice system in the Voice Announcement 
Manager tree and choose Edit Properties. 

Voice Announcement Manager will then display the Edit Voice System Properties dialog 
box.   

Setting up automatic login 

You can set up Voice Announcement Manager so that each time you start it, it 
automatically connects to the voice systems that you specify, if you have entered the 
voice system information for that system. 

There are two ways to set up Voice Announcement Manager so that it automatically 
connects. 

Option 1 

1 When you enter the voice system information, or anytime that you access the Edit 
Voice System Properties dialog box, simply check the Connect At Startup field. 

Option 2 

1 From the System menu, choose Connection At Startup Configuration. 

2 In the window that appears, place a check mark next to each voice system that you 
want Voice Announcement Manager to automatically connect to upon startup. 

3 Click OK. 
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Enabling and disabling virtual VAL boards 

Purpose of Enabling and Disabling 

In traditional voice systems, if you do not need the announcement capabilities of your 
VAL board, all you have to do is to remove the board from the slot. Since the Avaya 
G700 Media Gateway has no physical VAL board present, removing "the board" is not an 
option. Since, for security reasons, there must be some other mechanism to prevent the 
"virtual VAL board" from being used for announcements, 2 commands have been 
implemented on systems with "virtual VAL boards." These commands are:  

enabl e announcement  boar d <medi agat ewaynumber > and  

di sabl e announcement  boar d <medi agat ewaynumber > 

There is one important difference between enabling/disabling a virtual VAL board and 
removing a TN2501AP VAL board from a slot. Whether or not the virtual VAL board is 
enabled or disabled, you can still add/edit/delete announcement properties or FTP 
announcement files to the virtual VAL board. However, you can’t play an announcement 
if the virtual VAL board is disabled. In a traditional system, if you remove the VAL board, 
you can add/edit/delete the announcement properties file, but you cannot initiate an FTP 
file transfer. 

Prerequisites 

The enable command enables the virtual VAL board announcement capabilities. The 
disable command disables the virtual VAL board announcement capabilities. Before 
these commands can be issued, the virtual VAL board must be registered for gateway-
announcement.  

To register the virtual VAL board for gateway-announcement, the Media Gateway must 
be registered with Media Gateway Controller. Then, using your favorite system 
administration tool, execute the command change medi a- gat eway<MGnumber >.  On 
the form that appears, go to field labeled V9 and change the value to gat eway-
announcement .  An attempt to enable an announcement element that has not been 
registered with the Media Gateway Controller will be denied. 

Procedure 

To enable or disable a virtual VAL board, complete the following steps: 

1 Right-click a virtual VAL board from the list displayed in the main window. 

2 Click Enable or Disable. 

Voice Announcement Manager 2.0 supports 260 boards (250 virtual VAL boards and 10 
VAL boards) for S8700 voice systems and 50 virtual VAL boards for S8300 voice 
systems. 

You can also enable/disable a virtual VAL board via the Virtual VAL Board Status dialog 
box.  
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Testing Connectivity 

You can test Voice Announcement Manager’s connections to a voice system anytime.  
Doing so verifies that the LAN/WAN connections are working between the Voice 
Announcement Manager computer and the selected voice system, and that Voice 
Announcement Manager has the correct connectivity information.  

We recommend that you test Voice Announcement Manager’s connections after you first 
configure it, but before you use Voice Announcement Manager in day-to-day operations.  
We also recommend that you test Voice Announcement Manager’s connections after 
changing any connectivity information about the given voice system. 

To test connectivity to a voice system, either: 

 Click OK after you complete the Register Voice System dialog box for the first time, or 

 In the Voice Announcement Manager tree, right-click on the voice system you want to 
connect to, and choose Get VAL Board Information from the popup menu. 

If the connection is functional, you should be able to perform operations like view or 
change announcement properties. If the connection is not functional, Voice 
Announcement Manager will display an error message. For help understanding the error 
and fixing it, click the Troubleshooting button on the error message, and follow the 
instructions. 

Troubleshooting Voice Announcement Manager 

This topic summarizes Voice Announcement Manager troubleshooting resources and 
provides links to more information.  This topic covers only problems that may occur with 
the Voice Announcement Manager application, and between Voice Announcement 
Manager and the voice system it supports.   

Note: 
This topic does not cover problems that may occur on the VAL board or on the 
Communication Manager system.  

Connection Errors 

The following errors may appear as "message boxes" when Voice Announcement 
Manager fails to connect to a Communication Manager system.  If one of these errors 
occurs, Voice Announcement Manager displays the message, and you can click the 
Troubleshoot button to view the associated help topic.  These topics are listed again 
here for your reference, only. 

 

Too many users logged in  

Incorrect login  

Password has expired  

Remote reset  

Network connection failed  

Data is locked  

ASG is not enabled  

ASG is enabled  

Access denied  

Unexpected response from device  
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Invalid password  

General communications error  

NOTE: 
If you try to connect to a non-SSH based voice system (that is, a non-Linux based 
system) via an SSH connection, you will receive a connection failure error. In this case, 
try to connect to the voice system via a normal connection. 
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Using Voice Announcement Manager 

Creating a voice system login for Voice Announcement Manager 

When you add a voice system to Voice Announcement Manager and complete the 
Register Voice System dialog box for that system, you can use a Login Name that 
already exists on your voice system, or you can create one especially for Voice 
Announcement Manager.   

Creating a login especially for Voice Announcement Manager allows you to track what 
Voice Announcement Manager is doing on the given voice system. You can view the 
Communication Manager History Log and look at the activities being performed by the 
Login Name that you assign to Voice Announcement Manager. 

To create a new login on the voice system, you must have permissions on it to add and 
change logins. The login you create must be able to perform the following 
Communication Manager software commands: 
l i s t  conf i gur at i on al l  

l i s t  conf i gur at i on boar d 

di spl ay i p- i nt er f aces 

l i s t  node- names 

di spl ay syst em- par amet er s count r y- opt i ons 

l i s t  i nt egr at ed- annc- boar ds 

change announcement s 

l i s t  announcement s 

l i s t  di r ect or y boar d 

enabl e f i l esyst em boar d 

di sabl e f i l esyst em boar d 

enabl e announcement  boar d <medi agat ewaynumber > 

di sabl e announcement  boar d <medi agat ewaynumber > 

enabl e f i l exf er  

di sabl e f i l exf er  

add audi o- gr oup 

r emove audi o- gr oup 

change audi o- gr oup 

l i s t  i p- i nt er f ace 

l i s t  i p- i nt er f ace al l  

Note: 

If you have any difficulty with the procedure below, you can find additional, more 
generic instructions here. 

1 Using your favorite system administration tool, log in to the voice system. 

2 At the command line, enter add login <name> 

 Where <name> is the word you want to use as the login.  

3 Enter your password. 

 Verify that the Logi n Type:  field is set to customer.  

 Verify that the Ser vi ce Level :  field is set to super-user.  
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4 In the Logi n’ s passwor d:  field, enter the password that you want to associate 
with the administrative login. 

5 In the Reent er  Logi n’ s  passwor d:  field, enter the password again. 

6 If you want this login to use ASG, then in the Access Secur i t y  Gat eway? field, 
enter a y and complete the fields on page 2 of the form. 

Field Description 
 

Blocked Enter y to temporarily disable the login ID from accessing the 
voice system through ASG. 

System 
Generated 
Secret Key? 

To use ASG, either you or the voice system must generate a 
Secret Key, which you must enter on the voice system and in 
Voice Announcement Manager when you are configuring it. 
Enter a y to have the voice system generate the Secret Key. 

Secret Key If you want to create your own Secret Key, enter it in this field. 
Be sure to note the Secret Key; you will need it to configure 
Voice Announcement Manager and/or any response generation 
devices. 

The Secret Key must conform to the following requirements: 

 It must be 20 digits long. 

 Each digit must be between 0 (zero) and 7, inclusive. 

 The last number must be 0 (zero). 

 The next-to-last number must be 0 (zero), 2, 4, or 6. 
Expiration 
Date 

To disable this login after a certain date, enter the date in this 
field. If you enter a value in the Number of Sessions field, then 
the login will be disabled based on whichever criteria is satisfied 
first. 

Number of 
Sessions 

Enter the number of times this login ID can be used to access 
the voice system (between 1 and 999). If you enter a value in the 
Expiration Date field, then the login will be disabled based on 
whichever criteria is satisfied first. 

Restrict Days 
of Week 

Enter y to restrict this login from accessing the voice system on 
the specified day of the week. 

Restrict From 
Time and 
Restrict To 
Time 

Enter the time interval during which this login ID is blocked from 
accessing the voice system. 

 

7 Press Enter to submit the form. 

8 At the command line, enter change permissions <name>. 

 Where <name> is the word you used as the login in Step 2. The system displays the 
Command Permission Categories form.  

9 Set the fields to y to enable Voice Announcement Manager to perform the listed 
activity. 

 Use the table below to decide which of the fields to set to y. 

 The fields listed in the following table are for a basic voice system configuration. Your 
voice system may display more than the following fields. For help setting those fields, 
refer to the Administrator’s Guide for Avaya Communication Manager Software, 555-
233-506, as described in Contacting Us for Documentation. 
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Field Description 
 

Display Admin 
and Maint Data? 

Voice Announcement Manager can issue display, list, monitor, 
status, and schedule (reports) commands. 

System 
Measurements? 

Voice Announcement Manager can issue the list measurements 
command. 

System Mgmt 
Data Transfer 
Only? 

This field is not relevant to Voice Announcement Manager. 

Administer 
Stations? 

Voice Announcement Manager can issue add, change, 
duplicate, or remove commands for stations, data modules, and 
associated features, such as abbreviated dialing, vectors, and 
routing tables. 

Administer 
Trunks? 

Voice Announcement Manager can issue commands to 
administer AAR/ARS, trunk groups, remote access, and route 
patterns. 

Administer 
Features? 

Voice Announcement Manager can issue commands to 
administer feature-related system parameters, such as coverage 
paths, class of service, class of restriction, system parameters, 
authorization codes, and security. 

Administer 
Permissions? 

Voice Announcement Manager can issue commands to 
administer logins and command permissions. 

Restricted 
Objects? 

You can list any objects that Voice Announcement Manager 
cannot access, like stations, trunks, or hunt groups.  

 

10 Press Enter. 
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Creating a New Announcement 

Voice Announcement Manager does not offer announcement recording or editing 
functionality.  However, using other applications, you can record an announcement for 
callers to hear when they dial a specific extension or as part of call vectoring.  

The procedure for recording a new announcement is different depending on what 
recording method you use. Specifically, if you are recording a new announcement using a 
system phone, you MUST administer the announcement properties before you record the 
audio file. 

1 Administer the announcement properties. 

 This step must occur first only if you will be recording the audio using a system 
phone.  Otherwise, you can administer announcement properties after you record the 
audio. 

2 Record new announcements using one of the following methods: 

 Record using a professional studio  

 Record using a computer recording application  

 Record using a system phone  

Note: 
All audio files MUST conform to the VAL Audio File Format Requirements. 

3 Copy the announcement’s audio file to the Voice Announcement Manager computer, 
as follows: 

 If you recorded the file using a studio or third-party software, copy the file to the 
Voice Announcement Manager computer using Windows File Explorer. 

 If you recorded the file using your telephone, copy the file from the voice system to 
the Voice Announcement Manager computer using the instructions in Copying 
Audio Files to and from a voice system. 

Copying Audio Files to and from a Voice System 

To copy audio files to or from your voice system, complete the following steps: 

1 Using the Voice Announcement Manager Tree, navigate to the appropriate voice 
system. 

2 Right-click the appropriate VAL board and choose Copy/Delete Audio Files. 

 Voice Announcement Manager displays the Copy and Delete Audio Files dialog box.  

3 Complete the dialog box and click Close. 

 For help understanding this dialog box, click the Help button on the dialog box. 

CAUTION! 
When you copy an audio file to the VAL board, it first goes to the dynamic read-
only memory (RAM) on the board before being transferred to FLASH memory on 
the VAL board. During the 5 minutes that it takes for this to occur, if someone 
were to remove the VAL board or if the voice system were to lose power, then 
the audio file would be lost and you would have to copy it to the VAL board 
again. For more information, see "Non-volatile storage of announcements on 
VAL" in the chapter called "Managing Announcements" in the Administrator’s 
Guide for Avaya Communication Manager Software, 555-233-506. Search for it 
as described in Contacting Us for Documentation. 
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Viewing Announcement Properties 

To view the information pertaining to a particular announcement on your voice system, 
complete the following steps: 

1 Right-click the appropriate VAL board in the Voice Announcement Manager Tree and 
select View Announcement Properties.  

 You can also double-click the appropriate VAL board. Voice Announcement Manager 
displays the Announcement Properties window in the right pane. 

2 In the Announcement Properties window, right-click an announcement and choose 
Edit from the popup menu. 

 Voice Announcement Manager displays the Announcement Property dialog box. 

Changing Announcement Properties 

You can change any of the "properties " associated with a given announcement.  

Note 
Changing announcement properties does NOT change any aspect of the audio 
file associated with the announcement. That is a separate activity. 

To change announcement properties, complete the following steps: 

1 Right-click the appropriate VAL board in the Voice Announcement Manager Tree and 
select View Announcement Properties.  

 Voice Announcement Manager displays the Announcement Properties window for 
the selected VAL board in the right pane. 

2 Do one of the following: 

 Double-click in a cell and enter the change. Some fields are display-only and do not 
respond to the cursor. 

 Click in a cell and select a value. 

 Right-click the appropriate row in the Announcement Properties window, and 
choose Edit from the popup menu. The Announcement Property dialog box 
appears. Enter the change(s), and then click OK to save your changes. 

3 If necessary, click in another row to move the highlight bar away from the edited row. 

4 From the File menu, select Save Announcement Properties. 

 The changed announcement properties are saved to the Voice Announcement 
Manager computer and to the selected voice system. 



Voice Announcement Manager Reference 

17 

Deleting Audio Files 

To delete audio files from your voice system, complete the following steps: 

1 Using the Voice Announcement Manager Tree, navigate to the appropriate voice 
system. 

2 Right-click the appropriate VAL board and choose Copy/Delete Audio Files. 

 Voice Announcement Manager displays the Copy/Delete Audio Files dialog box.  

3 Be sure that the correct VAL board is listed at the top of the Files on VAL Board box. 

 If it is not the correct VAL board, click Close and start again. 

4 Select the audio file you want to delete from the box on the right and click Delete 
File. 

 A confirmation dialog box appears prompting whether you want to delete the 
corresponding announcement property.  

5 Perform one of the following steps: 

 If you want to delete the announcement property also, click Yes. 

 If you do not want to delete the announcement property, click No. 

6 Click Yes to delete the audio file. 

 Voice Announcement Manager deletes the selected audio file from the VAL board. 

Deleting announcement properties 

Voice Announcement Manager lets you delete announcement properties from either your 
Voice Announcement Manager computer or from your voice system. 

To delete announcement properties, complete the following steps: 

1 Using the Voice Announcement Manager Tree, navigate to the voice system 
containing the announcement properties that you want to delete. 

2 Right-click the appropriate VAL board and choose View Announcement Properties 
from the popup menu. 

 Voice Announcement Manager displays a table of announcement properties in the 
right pane. 

3 In the table, select the announcement that you want to delete. 

4 Right-click and choose Delete from the popup menu. 

 Voice Announcement Manager displays a confirmation message.  

 If the on board status of the announcement property is set to Y, (that is, the 
announcement is administered), you will have the option of deleting the associated 
audio file. Click Yes if you want to delete the audio file also. 

5 To delete the announcement, click Yes to the confirmation message. 

6 From the File menu, select Save Announcement Properties to delete the 
announcement properties from the Voice Announcement Manager computer and the 
selected voice system. 
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Deleting voice systems from Voice Announcement Manager 

Deleting a voice system from Voice Announcement Manager does not remove it 
anywhere else. It only affects what you see in the Voice Announcement Manager 
application. 

To remove a voice system from Voice Announcement Manager, complete the following 
steps: 

1 In the Voice Announcement Manager main window, perform one of the following 
steps: 

 Right-click a voice system in the Voice Announcement Manager tree, and choose 
Delete Voice System from the popup menu.  

 Select the voice system from the Voice Announcement Manager tree, and choose 
Delete Voice System from the System menu.  

 Voice Announcement Manager displays a confirmation message. 

2 To delete the voice system from Voice Announcement Manager, click Yes. 

Backing Up 

With Voice Announcement Manager, you can: 

 back up announcement properties and audio files for a single VAL/virtual VAL board 

 back up announcement properties and audio files for selected VAL/virtual VAL 
boards on a voice system that you select. (This voice system must be registered 
with Voice Announcement Manager.) 

 back up announcement properties and audio files for all VAL/virtual VAL boards on 
all of your voice systems (just the ones that Voice Announcement Manager knows 
about).  

With Voice Announcement Manager, you cannot back up based on a group of voice 
systems. 

Backing Up a Single VAL/Virtual VAL Board 

To back up announcement properties and audio files for a single VAL board, complete 
the following steps: 

1 From Voice Announcement Manager’s main window, do one of the following: 

 Right-click the VAL board in the Voice Announcement Manager tree and choose 
Back Up. 

 Select the VAL board in the Voice Announcement Manager tree, and choose Back 
Up from the Actions menu. 

 Voice Announcement Manager displays the Back Up dialog box. 

2 Complete the Back Up dialog box. 

 For help understanding the dialog box, click Help on that dialog box. 
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Backing Up Selected VAL/Virtual VAL Boards 

To back up announcement properties and audio files for selected VAL/virtual VAL boards 
on a voice system registered with Voice Announcement Manager, complete the following 
steps: 

1 From Voice Announcement Manager’s main window, do one of the following: 

 Right-click the voice system in the Voice Announcement Manager tree and choose 
Back Up. 

 Select the voice system in the Voice Announcement Manager tree, and choose 
Back Up from the Actions menu. 

 Voice Announcement Manager displays the Backup Selected VAL Boards dialog 
box. 

2 Complete the Backup Selected VAL Boards dialog box. 

 For help understanding the dialog box, click Help on that dialog box. 

Backing Up All VAL Boards 

Caution! 
This feature overwrites audio files and announcement properties on the Voice 
Announcement Manager computer when there are audio files or announcement 
properties with a matching name on the VAL board.  (This will NOT overwrite 
them if there are no matching audio files or announcement properties on the 
voice system.) 
 
Because the timestamp on audio files that are copied to the VAL board changes 
every time the files are copied (rather than showing the original creation date), 
comparing the timestamp of an audio file on the Voice Announcement Manager 
computer to the one on the VAL board does not accurately reflect which file is 
most recent.  For this reason, Voice Announcement Manager does not present 
you with timestamp information, and does not compare timestamps before 
copying.  
 
For this reason, before you use this feature, be absolutely certain that audio files 
and announcement properties on the voice system are the most recent. 
Otherwise you might overwrite more-recent files on the Voice Announcement 
Manager computer with old files from the voice system. 

To back up announcement properties and audio files on all voice systems that Voice 
Announcement Manager knows about, complete the following step: 

 From Voice Announcement Manager’s main window, do one of the following: 

 Right-click the Voice Systems node in the Voice Announcement Manager tree, and 
choose Back Up All. 

 Select the Voice System node in the Voice Announcement Manager tree, and 
choose Back Up All Voice Systems from the Actions menu. 
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Restoring 

With Voice Announcement Manager, you can: 

 restore announcement properties and audio files for a single VAL/virtual VAL board 

 restore announcement properties and audio files for selected VAL/virtual VAL 
boards on a voice system that you select. (This voice system must be registered 
with Voice Announcement Manager.) 

 restore announcement properties and audio files for all VAL/virtual VAL boards on 
all of your voice systems (just the ones that Voice Announcement Manager knows 
about).  

With Voice Announcement Manager, you cannot restore based on a group of voice 
systems. 

Restoring from a Single VAL Board 

To restore announcement properties and audio files from a single VAL/virtual VAL board, 
complete the following steps: 

1 From Voice Announcement Manager’s main window, do one of the following: 

 Right-click the VAL board in the Voice Announcement Manager tree, and choose 
Restore. 

 Select the VAL board in the Voice Announcement Manager tree, and choose 
Restore from the Actions menu. 

 A warning dialog box appears. 

2 Click Yes. 

 Voice Announcement Manager displays the Restore Audio Files and Announcements 
Properties dialog box. 

3 Complete the Restore Audio Files and Announcements Properties dialog box. 

 For help understanding the dialog box, click Help on that dialog box. 

Restoring from Selected VAL/Virtual VAL Boards 

To restore announcement properties and audio files from selected VAL/virtual VAL 
boards, complete the following steps: 

1 From Voice Announcement Manager’s main window, do one of the following: 

 Right-click the voice system in the Voice Announcement Manager tree, and choose 
Restore. 

 Select the voice system in the Voice Announcement Manager tree, and choose 
Restore from the Actions menu. 

 A warning dialog box appears. 

2 Click Yes. 

 Voice Announcement Manager displays the Select VAL Boards To Be Restored 
dialog box. 

3 Complete the Select VAL Boards To Be Restored dialog box. 

 For help understanding the dialog box, click Help on that dialog box. 
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Restoring all VAL Boards 

Caution! 
This feature overwrites audio files and announcement properties on the VAL 
board when there are audio files or announcement properties with a matching 
name on the Voice Announcement Manager computer.  (This will NOT overwrite 
them on the VAL board if there are no matching audio files or announcement 
properties on the Voice Announcement Manager computer.) 
 
Because the timestamp on audio files that are copied to the VAL board changes 
every time the files are copied to the VAL board (rather than reflecting the 
original creation date), comparing the timestamp of an audio file on the Voice 
Announcement Manager computer to the one on the VAL board does not 
accurately reflect which file is most recent.  For this reason, Voice 
Announcement Manager does not present you with timestamp information, and 
does not compare timestamps before copying.  
 
For this reason, before you use this feature, be absolutely certain that matching 
audio files and announcement properties on the Voice Announcement Manager 
computer are the most recent. Otherwise you might overwrite more-recent files 
on the voice system with old files from the Voice Announcement Manager 
computer. 

To restore announcement properties and audio files on all voice systems registered with 
Voice Announcement Manager, perform the following step: 

 From Voice Announcement Manager’s main window, do one of the following: 

 Right-click the Voice Systems node in the Voice Announcement Manager tree, and 
choose Restore All. 

 Select the Voice Systems node in the Voice Announcement Manager tree, and 
choose Restore All Voice Systems from the Actions menu. 

Viewing the Activity Log 

The activity log contains details of the actions that Voice Announcement Manager 
performs. This information is also displayed in the Status pane. 

To view the activity log, complete the following steps: 

1 Perform one of the following steps: 

 From the View menu, select View Logs. 

 Click the View Logs button on the toolbar. 

 A WordPad window appears displaying the contents of the activity log. The oldest 
record is displayed on the first line of the file, and the newest record is displayed on 
the last line of the file. 

2 When you are finished, close the WordPad window. 
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Viewing the Size of Audio Files 

The procedure describes how to view the properties for the audio files on the VAL/virtual 
VAL board you select. For each audio file, the following information is displayed: 

 name 

 size 

 length (in seconds) 

 time stamp  

To view a list of all audio files on a VAL/virtual VAL board, complete the following steps: 

1 Perform one of the following steps: 

 Right-click a VAL/virtual VAL board in the Voice Announcement Manager tree, and 
then choose View/Rename Audio Files Properties from the popup menu. 

 Select a VAL/virtual VAL board in the Voice Announcement Manager tree, and then 
choose View Audio Files Properties from the View menu. 

 Select a VAL/virtual VAL board in the Voice Announcement Manager tree, and then 
choose View/Rename Audio Files from the Actions menu. 

 Voice Announcement Manager displays the View Audio Files Properties dialog box. 

2 When finished, click Cancel. 

 

Moving Announcements between VAL Boards 

The procedure describes how to move announcement files from a VAL/virtual VAL board 
to another VAL board on the same voice system. You can also move the corresponding 
announcement property file. 

NOTE: 
You can also move announcement files from the Search Results window. 

To move announcements from a VAL/virtual VAL board, complete the following steps: 

1 Perform one of the following steps: 

 Right-click a VAL/virtual VAL board in the Voice Announcement Manager tree, and 
then choose Move Audio Files from the popup menu. 

 Select a VAL/virtual VAL board in the Voice Announcement Manager tree, and then 
choose Move Audio Files from the Actions menu. 

 Voice Announcement Manager displays the Move Announcement Files - Select Files 
To Move dialog box. 

2 Complete the Move Announcement Files - Select Files to Move dialog box, and click 
Next. 

The Move Announcement Files – Select Destination VAL Board dialog box appears.  

3 In the VAL Boards On box, select the VAL board to which you want to move the file, 
and click the > button. 

The VAL/Virtual VAL board you selected appears in the Destination VAL Board box. 

4 If you want to override the protected bit, click the Override Protected Bit check box. 

5 Click Finish to start the move. 
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Moving the Announcement Property between VAL Boards 

The procedure describes how to move the announcement administration/property (and 
the associated announcement file) from one VAL board to another on the same voice 
system. In this procedure, the announcement administration/property is copied to the 
destination VAL board and deleted from the source VAL board. 

NOTE: 
You can also move announcement files from the Search Result dialog box. 

To move an announcement property from a VAL/virtual VAL board, complete the 
following steps: 

1 Right-click the appropriate VAL board in the Voice Announcement Manager Tree and 
select View Announcement Properties.  

 Voice Announcement Manager displays the Announcement Properties table in the 
right pane. 

2 Right-click the announcement you want to move, and then choose Move from the 
popup menu. 

 Voice Announcement Manager displays the Move Announcement Property dialog 
box. 

3 Complete the Move Announcement Property dialog box, and click OK. 

 For help completing these fields, click the Help button on this dialog box. 

 

Broadcasting Announcement Files to VAL Boards 

The procedure describes how to broadcast announcement files to various VAL/virtual 
VAL boards on different voice systems.  

To broadcast announcement files, complete the following steps: 

1 From the Actions menu, select Broadcast.  

 Voice Announcement Manager displays the Broadcast Announcement Files - Select 
Files dialog box. 

2 Complete the Broadcast Announcement Files - Select Files dialog box, and click 
Next. 

 For help completing these fields, click the Help button on this dialog box. 
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Viewing/Changing the Status of Virtual VAL Boards 

This procedure describe how to  

 view the status of all the virtual VAL boards on a voice system 

 change the status of a virtual VAL board 

NOTE: 
You can perform this procedure only if a virtual VAL board is registered with the voice 
system. 

To view or change the status of virtual VAL boards, complete the following steps: 

1 Perform one of the following steps: 

 Right-click a voice system in the Voice Announcement Manager tree, and then 
choose View Virtual VAL Board Status from the popup menu. 

 Select a voice system in the Voice Announcement Manager tree, and then choose 
View Virtual VAL Board Status from the View menu. 

 Voice Announcement Manager displays the Virtual VAL Boards Status dialog box for 
the selected voice system. 

2 If you want to change the status of a board, perform one of the following steps: 

 If you want to enable a virtual VAL board, click on the Status cell for the board, and 
select Enabled. 

 If you want to disable a virtual VAL board, click on the Status cell for the board, and 
select Disabled. 

3 Click Update to save your changes. 

 

Configuring E-mail Notification 

This procedure describes how to you configure the default email notification information 
for Voice Announcement Manager. Unless you specify email addresses when you create 
a task, Voice Announcement Manager will send email about the outcome of the 
scheduled tasks to the addresses you enter in this procedure.  

To configure the default email notification information, complete the following steps: 

1 From the System menu, select Email Configuration. 

 The Configure Application Specific E-mail Notification dialog box appears. 

2 Complete the Configure Application Specific E-mail Notification dialog box. 

 For help completing these fields, click the Help button on this dialog box. 

 

Viewing Voice Announcement Manager Version 

To determine what version of Voice Announcement Manager you are using, choose 
Help>About. 
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Importing Announcement Properties 

Voice Announcement Manager lets you import voice announcement properties from a 
comma-separated values (CSV) file and send that data to a voice system. The CSV file 
may contain the following fields: 

 Number (required) 

 Name 

 Repeat 

 Extension 

 COR 

 Queue 

 Protect 

 Rate 

 TN 

 Port 

NOTE: 
If the COR, TN, Queue, Protect, Rate, or Port fields are blank, the defaults for these 
settings on the voice system will be used for the imported announcement properties. 

To import announcement properties from a CSV file, complete the following steps: 

1 Perform one of the following steps: 

 Right-click the voice system in the Voice Announcement Manager tree, and then 
choose Import Announcement Properties from the popup menu. 

 Select the voice system in the Voice Announcement Manager tree, and then 
choose Import Announcement Properties from the System menu. 

 The Import Data – Select Announcement Fields dialog box appears.  

2 In the Available fields box, select the field you want to import from the source file. 

3 Click the > button.  

The field you selected appears in the right box. 

Repeat steps 2 and 3 for each field you want to import. If you want to import all of the 
fields, click the >> button. 

NOTE: 
If the COR, TN, Queue, Protect, Rate, or Port fields are blank, the defaults for these 
settings on the voice system will be used for the imported announcement properties. 

4 Click Next. 

Voice Announcement Manager displays the Import Announcement Properties Wizard 
dialog box. 

5 Click Select. 

 The Open dialog box appears. 

6 Select the CSV file you want to import, and click Open.  

 If you want to view a sample file that is set up correctly, click View Sample File.  
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7 Perform one of the following steps: 

 If you want to add the announcement properties from the selected file to the 
voice system, select Add.  

 If you want to change the fields of the existing announcement properties on the 
voice system with the fields in the selected file, select Change. 

 If you want to delete all of the announcement properties on the voice system that 
correspond with the announcement properties in the selected file, select Delete. 

8 If you do not want to import the first row of data from the CSV file, click Yes.  

9 Click Next. 

 The Import Data - Summary dialog box appears. 

 If you want to make changes to the selected file, click View\Edit Import File, and 
make your changes. 

 If you want to schedule the import, click Schedule this task, and set the time and 
frequency. 

10 Click Finish. 

 If you are not scheduling this task, a status box appears showing the status of the 
import.  

 When the import is complete, the Import Announcement Properties Task dialog box 
appears. 

 Click View Logs if you want to view the Voice Announcement Manager activity log. 

11 When finished, click Close. 

 

Exporting Announcement Properties 

Voice Announcement Manager lets you export voice announcement properties from a 
voice system to a comma-separated values (CSV) file. You can specify which of the 
following fields will be exported to the CSV file: 

 Announcement Number  

 Extension 

 Type 

 COR 

 Name 

 Queue 

 Protect 

 Rate 

 Port 

To export announcement properties to a CSV file, complete the following steps: 

1 Perform one of the following steps: 

 Right-click the voice system in the Voice Announcement Manager tree, and then 
choose Export Announcement Properties from the popup menu. 

 Select the voice system in the Voice Announcement Manager tree, and then 
choose Export Announcement Properties from the System menu. 

 The Export Data – Filters dialog box appears. 
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2 In the Value box for the field in which you are interested, enter the value you want to 
export from the voice system. You may enter wildcard characters. 

3 Repeat Step 2 for any other fields in which you are interested.  

4 Click Next.  

 The Export Data – Fields dialog box appears. 

5 In the Available fields box, select the field you want to export.  

6 Click the > button.  

The field you selected appears in the right box. 

Repeat steps 5 and 6 for each field you want to export. If you want to export all of the 
fields, click the >> button. 

7 Click Next.  

 Voice Announcement Manager displays the Export Data – Announcement Properties 
dialog box. 

8 In the Export File box, enter the path and name for the file to which you will export the 
data. 

9 Select the Export Table Header check box if you want to export the table header 
information.  

 The Sample Export box shows the first several lines of data that will be exported. 

10 Click Next.  

 If the file to which you are exporting the data does not exist, a dialog appears 
prompting you to create the file. Click Yes. 

 The Export Data – Summary dialog box appears. 

 If you want to schedule the import, click Schedule this task, and set the time and 
frequency. 

11 Click Finish. 

 A status box appears showing the status of the export.  

 When the export is complete, the Export Announcement Properties Task dialog box 
appears.  

 Click View Logs if you want to view the Voice Announcement Manager activity log. 

12 When finished, click Close. 
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Printing Announcement Properties 

To print a list of announcement properties, complete the following steps: 

1 Right-click the appropriate VAL board in the Voice Announcement Manager Tree and 
select View Announcement Properties.  

 Voice Announcement Manager displays the Announcement Properties table in the 
right pane. 

2 Perform one of the following steps: 

 From the File menu, select Print Announcement Properties. 

 Click the Print button on the toolbar. 

NOTE: 
You can also print announcement properties from the Search Result dialog box. 

To preview how the announcement properties will be printed, complete the following 
steps: 

1 Right-click the appropriate VAL board in the Voice Announcement Manager Tree and 
select View Announcement Properties.  

 Voice Announcement Manager displays the Announcement Properties table in the 
right pane. 

2 Perform one of the following steps: 

 From the File menu, select Print Preview. 

 Click the Print Preview button on the toolbar. 

 

Configuring the Voice Announcement Manager properties 

From the Voice Announcement Manager window, you can configure the following system 
settings for Voice Announcement Manager: 

 the maximum file size for the activity log. By default, the file size for the activity log 
is 1 MB. If the file size reaches the limit you set, the file val_status.txt will be 
copied to the file val_status.txt.old, and Voice Announcement Manager will start 
logging messages in the new val_status.txt file. If the file val_status.txt.old 
already exists, that file will be overwritten. 

 the maximum number of threads spawned per voice system at a time. The threads 
perform FTP operation on a VAL board. By default, the value for this property will 
be 10. 

 the FTP mode (ACTIVE or PASSIVE). The default is ACTIVE. 

 the number of messages to be displayed in the Status pane. By default, 51 
messages will be displayed in the Status pane. 

 the editing software you want to use to view the activity log. The default editor is 
WordPad.  

 the audio player/editor software you want Voice Announcement Manager to start 
when you select Launch Audio player/Editor from the File menu.  

 the maximum number of minutes that you want Voice Announcement Manager to 
maintain its connection to the voice system.  

 the maximum number of seconds that you want Voice Announcement Manager to 
maintain its connection to the voice system after the last communication to the 
voice system.  
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 the number of seconds that you want to elapse before Voice Announcement 
Manager logs into a voice system. This delay is the number of seconds that elapse 
from when you request information from the voice system to when Voice 
Announcement Manager logs into that voice system. 

 whether you have to log into Voice Announcement Manager via a password. You 
can set Voice Announcement Manager to prompt you for a password every time 
you start Voice Announcement Manager. If you password protect Voice 
Announcement Manager, you must also specify an email address so Voice 
Announcement Manager can email you a copy of your password on request (for 
example, if you forget your password).  
 
If you enter the wrong password five consecutive times, Voice Announcement 
Manager will close. If you are unable log into Voice Announcement Manager (that 
is, you cannot remember your password), you must delete the file "ValManager.dat" 
and then start Voice Announcement Manager. Your tasks, templates, and other 
settings are preserved, but all of the voice system information is removed. You must 
re-enter the voice system information. 
 
NOTE: 
If you want to password protect Voice Announcement Manager, you must first 
configure the outgoing mail server information for Voice Announcement Manager.  

 

To configure the Voice Announcement Manager properties, complete the following steps: 

1 From the File menu, select Edit Application Properties. 

 The Edit Application Properties dialog box appears.  

2 In the Log Limit (in MB) box, enter the maximum file size for the activity log. The 
range is 1 to 5 MB. 

3 In the FTP Thread Limit box, enter the maximum number of threads spawned per 
voice system at a time. The range is 1 to 25. 

4 From the FTP Connect Mode box, select the FTP mode. 

5 In the Status Pane Messages box, enter the maximum number of messages to be 
displayed in the Status pane. The range is 1 to 250. 

6 From the Log Editor box, select the editing software that will be used to view the 
activity log. 

7 From the Audio Player/Editor box, select the audio player/editor software you want 
Voice Announcement Manager to start when you select Launch Audio 
player/Editor from the File menu. 

8 In the Login Duration box, enter the maximum number of minutes that you want 
Voice Announcement Manager to maintain its connection to the voice system. 

9 In the Connection Timeout box, enter the maximum number of seconds that you want 
Voice Announcement Manager to maintain its connection to the voice system after 
the last communication to the voice system. 

10 In the Login Delay box, enter the number of seconds that must elapse before Voice 
Announcement Manager logs into a voice system. This delay is the number of 
seconds that elapse from when you request information from the voice system to 
when Voice Announcement Manager logs into that voice system. 



Voice Announcement Manager Reference 

30 

11 If you want to configure Voice Announcement Manager to prompt you for a password 
when you start Voice Announcement Manager, perform the following steps: 

a. Click the Authentication Required check box. 

b. In the Password box, enter the password you want to use to log into Voice 
Announcement Manager. 

c. In the Re-enter Password box, enter the password you want to use to log into 
Voice Announcement Manager. 

d. In the E-mail ID box, enter the email address to which you want Voice 
Announcement Manager to email your password. This setting is valuable if you 
forget your password. 

12 Click Save. 

NOTE: 
If you tried to configure a password for Voice Announcement Manager, but you did not 
configure the outgoing mail server information for Voice Announcement Manager 
previously, an error message appears. Perform the following steps: 

1 Click OK to close the error message box. 

2 Uncheck the Authentication Required check box. 

3 Configure the outgoing mail server information for Voice Announcement Manager. 

4 Perform Steps 11 and 12 in this procedure to password protect Voice Announcement 
Manager. 

 

Using the online help system 

The online help system you are reading explains how to perform the most common Voice 
Announcement Manager and announcement-related tasks.  

To Access the Online Help 

 Choose Help>Contents to open the help system. 

To Use the Online Help 

 Choose Help>About to learn which version of Voice Announcement Manager you are 
using. 

 Once the online help system is open: 

 Click the Contents tab to view a table of contents of help topics. 

 Click the Index tab and type a word to search for a help topic 

 Click the Search tab to search the entire online help system for a particular word or 
phrase. 

NOTE: 
The first time you click Search, a wizard takes you through the steps to create a 
database of all the words in the help system.  

 

Exiting Voice Announcement Manager 

To exit the application, choose File>Exit. 

If you have changed information in the Announcement Properties table but forgot to save, 
Voice Announcement Manager will ask if you want to save your changes before exiting. 
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Working with Audio Groups and Folders 

Creating an audio group folder 

To create an audio group folder, complete the following steps: 

1 Right-click on Audio Sources or Audio Groups in the Voice Announcement Manager 
tree, and then choose Create New Folder from the popup menu. 

 The new folder appears in the Voice Announcement Manager tree. It is labeled "New 
Folder."  

2 To change the name of this folder, right-click on this folder, and then choose Rename 
from the popup menu. 

 The cursor appears at the end of the folder name. You can now change the name of 
this folder.  

3 Enter the name for this folder. 

4 When finished, click the mouse outside the name for this folder. 

 

Renaming an audio group folder 

To rename an audio group folder, complete the following steps: 

1 Right-click on the audio group folder you want to rename in the Voice Announcement 
Manager tree, and then choose Rename from the popup menu. 

 The cursor appears at the end of the folder name. You can now change the name of 
this folder.  

2 Enter the name for this folder. 

3 When finished, click the mouse outside the name for this folder. 

 

Deleting an audio group folder 

NOTE: 
You can only delete an audio group folder that is empty. 

To delete an existing audio group folder, complete the following steps: 

1 Right-click on the audio group folder you want to delete from the Voice 
Announcement Manager tree, and then choose Delete from the popup menu. 

 A warning dialog box appears.  

2 Click Yes to delete the folder. 

 

Creating an audio group 

To create an audio group, complete the following steps: 

1 Perform one of the following steps: 

 Right-click on an audio group (if any) in the Voice Announcement Manager tree, 
and then choose Create/Edit Group from the popup menu. 

 Select an audio group (if any) in the Voice Announcement Manager tree, and then 
choose Create/Edit Group from the Actions menu. 

 The Create/Edit Group dialog box appears. 

2 Click the Create New Group option button. 

3 From the Group No. box, select the number for this group. 
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4 In the Group Name box, enter the name for this group. 

5 In the Available Announcement Sources box, select the announcement sources you 
want to add to this group, and click the > button. If you want to add all of the 
announcement sources, click the >> button. 

The announcement sources you selected appear in the Group Members box. 

If you make a mistake, highlight the mistake in the Group Members box and click the < 
button, or click Cancel to start over. 

6 Click OK. 

After the group is created, the Create Group Task dialog box appears. 

 

Modifying an audio group 

To modify an existing audio group, complete the following steps: 

1 Perform one of the following steps: 

 Right-click on an audio group (if any) in the Voice Announcement Manager tree, 
and then choose Create/Edit Group from the popup menu. 

 Select an audio group (if any) in the Voice Announcement Manager tree, and then 
choose Create/Edit Group from the Actions menu. 

 The Create/Edit Group dialog box appears. 

2 Click the Edit Group option button. 

3 From the Group No. box, select the number of the group you want to modify. 

The information for the selected group appears. 

4 Make your changes. 

5 When finished, click OK. 

After the group is modified, the Edit Group Task dialog box appears. 

 

Deleting an audio group 

To delete an existing audio group, complete the following steps: 

1 Perform one of the following steps: 

 Right-click on an audio group (if any) in the Voice Announcement Manager tree, 
and then choose Create/Edit Group from the popup menu. 

 Select an audio group (if any) in the Voice Announcement Manager tree, and then 
choose Create/Edit Group from the Actions menu. 

 The Create/Edit Group dialog box appears. 

2 Click the Edit Group option button. 

3 From the Group No. box, select the number of the group you want to delete. 

The information for the selected group appears. 

4 Click Delete. 

A warning dialog box appears. 

5 Click Yes to delete the group. 

After the group is deleted, the Delete Group Task dialog box appears. 
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Moving audio groups into different folders 

Use this procedure to move an audio group to a different audio group folder. By default, 
all audio groups are located in the Default Folder. 

To move an audio group into a different folder, complete the following steps: 

1 Click and hold down the mouse on the audio group you want to move into a different 
folder in the Voice Announcement Manager tree. 

2 Drag the mouse onto the destination audio group folder, and release the mouse. 

 The selected audio group appears in the destination folder.  
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Searching 

Searching for Audio Files 

Voice Announcement Manager lets you search for audio files on your voice system. 
During this search, Voice Announcement Manager will "search" the names of the audio 
files on the voice system you specify. You can specify to search all of your voice 
systems. 

To search for an audio file, complete the following steps: 

1 Perform one of the following steps: 

 Right-click Voice Systems in the Voice Announcement Manager tree, and then 
choose Search Announcement Property/File from the popup menu. 

 Select Voice Systems in the Voice Announcement Manager tree, and then choose 
Search Announcement Property/File from the System menu. 

 Right-click the voice system you want to search in the Voice Announcement 
Manager tree, and then choose Search Announcement Property/File from the 
popup menu. 

 Select the voice system you want to search in the Voice Announcement Manager 
tree, and then choose Search Announcement Property/File from the System 
menu. 

 Voice Announcement Manager displays the Search Task dialog box. 

2 From the Voice System box, select the voice system you want to search. If you want 
to search all of the voice systems, select All Voice Systems. 

3 From the Announcement box, select File. 

4 From the box, specify how you want to perform the search. Choices are equals, 
contains, starts with, and ends with.  

5 In the Value box, enter the information you want to find.  

6 Click Search. 

 Voice Announcement Manager displays a status box that shows the status of the 
search.  

 When the search is completed, the Search Results dialog box appears. 

7 Click OK. 

 The audio files that match your search criteria are displayed. 
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Searching for Announcement Property Files 

Voice Announcement Manager lets you search for announcement property files on your 
voice system. You can specify up to two of the following search criteria: 

 Name 

 Extension 

 Type 

 COR 

 TN 

 Queue 

 Protected 

 Board/Annc. Group 

 Length 

 On Board 

You can specify to search all of your voice systems. 

To search for an announcement property file, complete the following steps: 

1 Perform one of the following steps: 

 Right-click Voice Systems in the Voice Announcement Manager tree, and then 
choose Search Announcement Property/File from the popup menu. 

 Select Voice Systems in the Voice Announcement Manager tree, and then choose 
Search Announcement Property/File from the System menu. 

 Right-click the voice system you want to search in the Voice Announcement 
Manager tree, and then choose Search Announcement Property/File from the 
popup menu. 

 Select the voice system you want to search in the Voice Announcement Manager 
tree, and then choose Search Announcement Property/File from the System 
menu. 

 Voice Announcement Manager displays the Search Task dialog box. 

2 From the Voice System box, select the voice system you want to search. If you want 
to search all of the voice systems, select All Voice Systems. 

3 From the Announcement box, select Property. 

4 From the Property Name box, select the first search criterion you want to use.  

5 From the next box, specify how you want to perform the search. Choices are equals, 
contains, starts with, and ends with.  

6 In the Value box, enter the information you want to find.  

7 If you want to use a second search criterion, perform the following steps: 

a. From the next box, select whether the second search criterion is required. Select 
either AND or OR. If you select NONE, the second search criterion will not be 
used. 

b. From the next Property Name box, select the second search criterion you want to 
use. 

c. From the next box, specify how you want to perform the search. Choices are 
equals, contains, starts with, and ends with. 
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d. From the next Value box, enter the information you want to find. 

8 Click Search. 

 Voice Announcement Manager displays a status box that shows the status of the 
search.  

 When the search is completed, the Search Results dialog box appears. 

9 Click OK. 

 The announcement property files that match your search criteria are displayed. 

 

Searching for VAL sources in an audio group 

Voice Announcement Manager lets you search for a VAL source within audio groups in a 
voice system. 

To find a VAL source, complete the following steps: 

1 Perform one of the following steps: 

 Right-click the voice system in the Voice Announcement Manager tree, and then 
choose Search/Replace VAL Sources in Group from the popup menu. 

 Select the voice system in the Voice Announcement Manager tree, and then 
choose Search/Replace VAL Sources in Group from the Actions menu. 

2 Click the Find option button. 

3 In the Available VAL Sources box, select the VAL source you want to find and click 
the > button.  

The VAL source you selected appears in the VAL Sources to be searched box. 

4 Click OK. 

The Search Results for groups dialog box appears and displays the number and name of 
the group that contains this VAL source. 

 

Replacing VAL sources in an audio group 

Voice Announcement Manager lets you find and replace a VAL source within audio 
groups in a voice system. 

To find and replace a VAL source, complete the following steps: 

1 Perform one of the following steps: 

 Right-click the voice system in the Voice Announcement Manager tree, and then 
choose Search/Replace VAL Sources in Group from the popup menu. 

 Select the voice system in the Voice Announcement Manager tree, and then 
choose Search/Replace VAL Sources in Group from the Actions menu. 

2 Click the Find and Replace option button. 

3 In the Available VAL Sources box, select the VAL source you want to find and 
replace, and click the > button.  

The VAL source you selected appears in the VAL Sources to be searched box. 

4 Click Next. 

5 In the Available VAL Sources box, select the VAL source you want to use as the 
replacement, and click the > button.  

The VAL source you selected appears in the VAL Sources to be replaced box. 
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6 Click Finish. 

The Search and Replace VAL Sources Success dialog box appears. 

7 Click Close. 

 

Scheduling 

Creating a Task 

The procedure describes how to create a task that you can schedule to run at a specified 
date, time, and frequency. For example, you can create a task that will back up the 
announcement files from different VAL/virtual VAL boards on a voice system on regular 
basis. 

You can create tasks to perform the following actions: 

 back up selected VAL boards  

 back up all voice systems 

 broadcast announcements 

 import voice announcement properties from a comma-separated values (CSV) file and 
send that data to a voice system 

 export voice announcement properties from a voice system to a comma-separated 
values (CSV) file 

To create a task, complete the following steps: 

1 From the Actions menu, choose Scheduler.  

 The Task Editor dialog box appears. 

2 Click Add. 

 The Create Task dialog box appears. 

3 Complete the Create Task dialog box, and click OK. 

 For help completing these fields, click the Help button on this dialog box. 

 

Modifying a Task 

To modify a task, complete the following steps: 

1 From the Actions menu, choose Scheduler.  

 The Task Editor dialog box appears. 

2 Select the task you want to modify, and then click Modify. 

3 Make your changes to the task. 

 For help completing these fields, click the Help button on this dialog box. 

 

Deleting a Task 

To delete a task, complete the following steps: 

1 From the Actions menu, choose Scheduler.  

 The Task Editor dialog box appears. 

2 Select the task you want to delete, and then click Delete. 

 For help, click the Help button on this dialog box. 
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Stopping a Scheduled Task 

To stop a scheduled task from being performed, complete the following steps: 

1 From the Actions menu, choose Scheduler.  

 The Task Editor dialog box appears. 

2 Select the task you want to stop, and then click Abort. 

 For help, click the Help button on this dialog box. 

 

Deleting Completed Tasks 

To delete all of the completed tasks (that is, tasks that completed successfully and tasks 
that completed with errors), complete the following steps: 

1 From the Actions menu, choose Scheduler.  

 The Task Editor dialog box appears. 

2 Click Clear. 

 For help, click the Help button on this dialog box. 

All of the completed tasks are deleted. 
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Using Templates 

Creating a Template 

This procedure describes how to create a new template that will perform one of the 
following actions: 

 back up selected VAL boards  

 back up all voice systems 

 broadcast announcements 

 import voice announcement properties from a comma-separated values (CSV) file and 
send that data to a voice system 

 export voice announcement properties from a voice system to a comma-separated 
values (CSV) file 

Once you create a template, you can modify it and easily create tasks that you can 
schedule.  

When creating a template, you can specify that you do not want this template to be 
scheduled by selecting the Template only: Do not schedule check box in the Create 
Template dialog box. 

To create a template, complete the following steps: 

1 From the Actions menu, choose Template Editor.  

 The Template Editor dialog box appears. 

2 Click Add. 

 The Create Template dialog box appears. 

3 Complete the Create Template dialog box.  

If you do not want this template to be scheduled, click the Template only: Do not 
schedule check box. 

For help completing the fields in this dialog box, click the Help button on this dialog 
box. 

4 When finished, click Next. 

 

Modifying a Template 

To modify a template, complete the following steps: 

1 From the Actions menu, choose Template Editor.  

 The Template Editor dialog box appears. 

2 Select the template you want to modify, and then click Edit. 

3 Make your changes to the template. 

If you do not want this template to be scheduled, click the Template only: Do not 
schedule check box. 

 For help completing these fields, click the Help button on this dialog box. 

4 When finished, click Next. 
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Deleting a Template 

To delete a template, complete the following steps: 

1 From the Actions menu, choose Template Editor.  

 The Template Editor dialog box appears. 

2 Select the template you want to delete, and then click Delete. 

 For help, click the Help button on this dialog box. 

OR 

1 In the Task Editor, click the Add button.  

 The Create Task dialog box appears, displaying a list of templates. 

2 Select the templates you want to delete, and then click Delete. 

 For help, click the Help button on this dialog box. 
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Screen Reference 

Menus 
 

Menu and Option Function 

File menu 

File>Save 
Announcement 
Properties 

This option saves changed data in the announcement table 
to the Voice Announcement Manager computer and to the 
selected voice system.  

File>Print 
Announcement 
Properties 

This option prints the announcement properties. 

File>Print Preview 
Announcement 
Properties 

This option enables you to see the format in which the 
announcement properties will be printed. 

File>Edit Application 
Properties 

This option enables you to configure the following settings 
in the Voice Announcement Manager properties file: 

 the maximum size for the activity log. 

 the maximum number of threads spawned per voice 
system at a time. 

 the FTP mode (ACTIVE or PASSIVE). 

 the number of messages to be displayed in the 
Status pane. 

 the editing software you want to use to view the 
activity log. 

 the audio player/editor software you want 
Announcement Manager to start when you select 
Launch Audio player/Editor from the File menu. 

 the maximum number of minutes that you want 
Voice Announcement Manager to maintain its 
connection to the voice system. 

 the timeout interval for which you want Voice 
Announcement Manager to try connecting to the 
voice system. 

 whether you have to log into Voice Announcement 
Manager via a password. You can set Voice 
Announcement Manager to prompt you for a 
password every time you start Voice Announcement 
Manager. If you password protect Voice 
Announcement Manager, you must also specify an 
email address so Voice Announcement Manager can 
email you a copy of your password on request (for 
example, if you forget your password). 
 
If you enter the wrong password five consecutive 
times, Voice Announcement Manager will close. If 
you are unable log into Voice Announcement 
Manager (that is, you cannot remember your 
password), you must delete the file 
"ValManager.dat" and then start Voice 
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Announcement Manager. Your tasks, templates, and 
other settings are preserved, but all of the voice 
system information is removed. You must re-enter 
the voice system information. 
 
NOTE: 
If you want to password protect Voice 
Announcement Manager, you must first configure 
the outgoing mail server information for Voice 
Announcement Manager. 

 

File>Edit SCP Server 
Configuration 

This option enables you to configure the settings to use 
SCP for secure file transfer. 

NOTE: 
SCP is only supported for G350, G250, G250-DCP, and 
G250-DS1 media gateways. 

File>Launch Audio 
player/Editor 

This option opens the audio player/editor application you 
specified in the Edit Application Properties dialog box. 

File>Exit This option closes the application. Voice Announcement 
Manager displays a warning if you have changed any data 
in the announcement table but forgotten to save it. 

View menu 

View>Refresh 
Announcement 
Properties 

This option makes Voice Announcement Manager contact 
the voice system, update the announcement table with any 
changes, and re-display the table. 

View>Edit Properties Select this option to view the VAL Board Properties dialog 
box for the VAL board that you selected in the Voice 
Announcement Manager tree. 

View>View Logs Select this option to view the Voice Announcement 
Manager activity log. 

View>View Audio 
Files Properties 

In the Voice Announcement Manager tree, select the 
specific VAL board associated with the announcement 
properties you want to view, and then select this option.  
When you do, Voice Announcement Manager will display 
these announcement properties in View Audio File 
Properties dialog box. 

View>View 
Announcement 
Properties 

In the Voice Announcement Manager tree, select the 
specific VAL board, and then select this option. The Voice 
Announcement Manager presents the Announcement 
Properties window, which you can use to create new 
announcements, modify existing announcements, delete 
announcements, or transfer announcement files 
corresponding to the announcements.  

View>View Virtual 
VAL Boards Status 

In the Voice Announcement Manager tree, select the voice 
system, and then select this option. Voice Announcement 
Manager presents a dialog box that displays the status 
each virtual VAL board on the selected voice system. From 
this dialog box, you can change the status of the VAL 
boards.  

View>View Voice 
System Tree 

This option lets you display or hide the left pane (the Tree) 
of the main window. 
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View>View Status 
Pane 

This option lets you display or hide the bottom pane (the 
Status pane) of the main window. 

Edit menu 

Edit>New 
Announcement 
Property 

Select this option to add a new announcement to the 
selected voice system. 

Edit>Edit 
Announcement 
Property 

Select this option you to modify to the properties of the 
selected announcement in the Voice Announcement 
Manager window. 

Edit>Move 
Announcement 
Property 

Select this option to move the properties of the selected 
announcement in the Voice Announcement Manager 
window. 

Edit>Rename 
Announcement 
Property 

Select this option to rename the selected announcement 
property in the Voice Announcement Manager window. 

Edit>Delete 
Announcement 
Property 

Select this option to delete the selected announcement in 
the Voice Announcement Manager window. 

System menu 

System>Register 
Voice System 

Select this option to add a new voice system to Voice 
Announcement Manager. 

System>Delete Voice 
System 

In the Voice Announcement Manager tree, select the voice 
system you want to remove, and then select this option.  
Deleting a voice system using this option does not affect 
the voice system. 

System>Get VAL 
Board Information 

In the Voice Announcement Manager tree, select a VAL 
board, and select this option. The Edit VAL Board 
Properties dialog box appears, displaying the properties for 
the selected board. 

System>Connect At 
Startup Configuration 

Select this option if you want to specify which voice 
systems Voice Announcement Manager should connect to 
upon startup. 

System>Email 
Configuration 

Select this option to configure the default email addresses 
to which Voice Announcement Manager will send email 
when scheduled tasks are performed. 

System>Search 
Announcement 
Property/File 

Select this option to search for announcement properties 
and audio files on a voice system. You can specify to 
search all of your voice systems. 

System>Import 
Announcement 
Properties 

Select this option to import voice announcement properties 
from a comma-separated values (CSV) file. 

System>Export 
Announcement 
Properties 

Select this option to export voice announcement properties 
to a comma-separated values (CSV) file. 

System>Sort Voice 
Systems By Name 

Select this option to display the voice systems in 
alphabetical order. 
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Actions menu 

Actions>Back Up In the Voice Announcement Manager tree, select the voice 
system that contains the announcement properties and 
audio files you want to copy to the Voice Announcement 
Manager computer, and then select this menu option. 

Actions>Back Up All 
Voice Systems 

This option lets you copy announcement properties from all 
of the voice systems to Voice Announcement Manager’s 
"persistent storage" and lets you copy audio files from all of 
the VAL boards (that you have registered with Voice 
Announcement Manager) to the directories that you 
associated with these VAL boards.  

Actions>Restore In the Voice Announcement Manager window, select the 
voice system to which you want to copy the 
announcements from the Voice Announcement Manager 
computer, and then select this menu option. 

Actions> Restore All 
Voice Systems 

This option copies all announcement properties from the 
Voice Announcement Manager’s "persistent storage" to the 
appropriate Communication Manager forms, and copies all 
audio files from the Voice Announcement Manager 
computer to the appropriate VAL boards. 

Actions>Copy/Delete 
Audio Files 

In the Voice Announcement Manager window, select the 
VAL board to which you want to copy audio files from the 
Voice Announcement Manager computer or vice versa, and 
then select this menu option. Using this menu option, you 
can also delete audio files.  

Actions>Move Audio 
Files 

In the Voice Announcement Manager tree, select the VAL 
board that contains announcement files you want to move, 
and then select this option. Voice Announcement Manager 
presents the Move Announcement Files - Select Files To 
Move dialog box.  

Actions>View/Renam
e Audio Files 

In the Voice Announcement Manager tree, select the VAL 
board that contains announcement files you want to move, 
and then select this option. Voice Announcement Manager 
presents the Move Announcement Files - Select Files To 
Move dialog box.  

Actions>Enable 
Virtual VAL Board 

In the Voice Announcement Manager tree, select the virtual 
VAL board you want to enable, and then select this option.  

Actions>Disable 
Virtual VAL Board 

In the Voice Announcement Manager tree, select the virtual 
VAL board you want to disable, and then select this option.  

Actions>Create/Edit 
Group 

Using this menu option, you can create a new audio group 
or modify an existing audio group for the selected voice 
system.  

Actions>Search/Repl
ace VAL Sources in 
Group 

Using this menu option, you can find VAL sources in an 
audio group in a voice system and replace VAL sources in 
an audio group in a voice system. 
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Actions>Move 
Announcement 
Properties 

This option enables you to move the 
announcement/administration/properties (and the 
associated announcement file) from one VAL board to 
another on the same voice system. In the Voice 
Announcement Manager tree, select the specific VAL 
board, and then select this option. 

Actions>Broadcast Using this menu option, you can broadcast announcement 
files onto various VAL boards on different voice systems.  

Actions>Scheduler Using this menu option, you can create, modify, delete, and 
manage tasks that you can schedule to be performed at 
specific times and intervals.  

Actions>Template 
Editor 

Using this menu option, you can create, modify, and delete 
templates.  

Window menu 

Window>Cascade Overlaps the Announcement Properties windows and 
displays the title bar of each window.  

Window>Tile 
Horizontally 

Displays each Announcement Properties window from left 
to right.  

Window>Tile 
Vertically 

Displays each Announcement Properties window from top 
to bottom.  

Window>Close All Closes all of the Announcement Properties windows.  

Window>Open 
Announcement 
Properties 

Displays the title of each Announcement Properties window 
that is currently open. A check mark indicates that the 
corresponding window has focus. Select the title of the 
window you want to view. 

Help menu 

Help>Contents Select this option to view the Voice Announcement 
Manager online help system. 

Help>About Select this option to view the version number and other 
pertinent data about this release of Voice Announcement 
Manager. 
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Announcement Properties window 

This window displays the values from the following Communication Manager fields for 
each announcement on the selected VAL board/virtual VAL board. You can also view 
these fields by accessing the selected voice system with your favorite system 
administration tool and entering change announcements at the command line to display 
the Announcements/Audio Sources screen. 

Field Description 

Name 27-character alpha-numeric filename for the audio file (no 
'.', '/', ':', '*', '?', '<', '>', '\', or blanks).  

Note: 
In Voice Announcement Manager, the ".wav" file extension, 
which is part of the filename stored on the circuit pack, 
does appear. You must enter ".wav" as part of the filename.  

Repeat A yes/no field that indicates whether the announcement is 
repeating.  

Music A yes/no field that indicates whether the announcement 
property is for music.  

Ext Valid extension number for the announcement.  

COR See COR. 

Protect Default is n, meaning that the announcement file read-write. 
Use this value when you initially administer the 
announcement. After an announcement file resides on the 
circuit pack (recorded or FTP transfer), you can set this 
field to y to protect the file (read-only). 

Queue Announcement queuing/barge-in 

n (default), means that the announcement does not play if a 
port is not available. 

y means that the request queues when all ports on the 
circuit pack are busy. The announcement plays when a port 
becomes available. This setting is recommended for most 
call center applications. 

b means that you can connect callers to the announcement 
at any time while it is playing. With n or y, the caller is 
always connected to the beginning of the announcement. 

TN See TN. 

Rate If the VAL board is administered on the circuit packs form, 
then 64 (64Kbps) automatically displays in the Rat e field.  

Size The size of the audio file in kilobytes.  

Timestamp The date and time the audio file was created or modified. 
This changes each time the audio file is put on the VAL 
board using FTP.  

On Board This yes/no field indicates whether the announcement’s 
audio file exists on the VAL board. 

Length The length in seconds of the announcement.  
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Back Up Audio Files and Announcements Properties dialog box 

This dialog box lets you back up your announcements files from VAL/virtual VAL boards 
you select to a location on your Voice Announcement Manager computer. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

 Right-click a VAL board in the Voice Announcement Manager tree, and then choose 
Backup from the popup menu. 

 Select a VAL board in the Voice Announcement Manager tree, and then choose 
Backup from the Actions menu. 

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 At the top of the Files to Back Up box, be sure the location where you want to back 
files up to is displayed. 

 If it is not, click Change Folder and select the location where you want the files to go. 

2 At the top of the File on VAL Board box, be sure the correct voice system and 
VAL/virtual VAL board is displayed (Voice system: VAL/virtual VAL board). 

 If it is not, click Cancel and start over, being sure to select the correct VAL board 
first. 

3 In the File on VAL Board box, highlight the announcements that you want to back up 
and click the < button. 

The prefix "AF" indicates that both the announcement property and the .wav file are 
present for that announcement. Prefix "F" indicates that only .wav file is present and 
prefix "A" indicates that only announcement property file is present. 

If you make a mistake, highlight the mistake in the Files to Back Up box and click the > 
button, or click Cancel to start over. 

4 Repeat Step 3 until you have specified all of the announcements on this board that 
you want to back up to the specified location on the Voice Announcement Manager 
computer. 

5 Click one of the following: 

 OK to execute the backup and close the dialog box 

 Apply to execute the backup and leave the dialog box open. 

 Cancel to abort the backup and close the dialog box. 

 Help for assistance understanding this dialog box. 
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Back Up Selected VAL Boards and Groups dialog box 

This dialog box lets you back up your announcements from the VAL/virtual VAL boards 
and groups you select to a location you select on your Voice Announcement Manager 
computer. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

 Right-click a voice system in the Voice Announcement Manager tree, and then choose 
Back Up from the popup menu. 

 Select a voice system in the Voice Announcement Manager tree, and then choose 
Back Up from the Actions menu. 

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 At the top of the Administered VAL Boards box, be sure the correct voice system is 
displayed. 

 If it is not, click Cancel and start over, being sure to select the correct voice system 
first. 

2 In the Administered VAL Boards box, highlight the VAL/virtual VAL boards that you 
want to back up and click the > button. If you want to back up all of the boards, either 
click the >> button or select the voice system and click the > button. 

The files you select appear in the Selected VAL Boards to Back Up box. 

If you make a mistake, highlight the mistake in the Selected VAL Boards to Back Up box 
and click the < button, or click Cancel to start over. 

3 Repeat Step 2 until you have specified all of the boards that you want to back up to 
the specified location on the Voice Announcement Manager computer. 

4 If you use the same file in multiple VAL sources, select the Use file from first 
available source for all sources check box. Voice Announcement Manager will copy 
the file from the first member in the group that has the file to each member. This 
option reduces the time to back up files to all members.  

5 Click one of the following: 

 OK to execute the backup and close the dialog box 

 Apply to execute the backup and leave the dialog box open. 

 Cancel to abort the backup and close the dialog box. 

 Help for assistance understanding this dialog box. 
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Broadcast Announcement Files - Select Files by Extension dialog box 

This dialog box lets you select the extensions that you want to use to broadcast 
announcement files to a group of VAL sources. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by performing either of the 
following steps:  

To perform a broadcast now: 

1 Choose Broadcast from the Actions menu. 

The Broadcast Announcement Files - Select Files dialog box appears. 

2 Click Broadcast by Ext.  

To schedule a broadcast: 

1 From the Actions menu, choose Scheduler. 

The Task Editor dialog box appears. 

2 Click Add.  

 The Create Task dialog box appears. 

3 Click the Create New Task option button, and click OK.  

 The Create New Task dialog box appears. 

4 Enter the appropriate information, click the Broadcast option button, and then 
click Next.  

5 Click Broadcast by Ext.  

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 From the Voice System box, select the voice system that contains the extensions you 
want to broadcast. 

2 In the Extension box, enter the extension you want to broadcast, and click Add. 

The corresponding audio file appears in the Select Files to Broadcast box. You can select 
more than one file to broadcast from different voice systems. 

3 Repeat Steps 1 and 2 for each extension you want to broadcast. 

4 When finished, click OK. 

The Broadcast Announcement Files – Select Files dialog box appears. The audio files 
you selected appear in the Selected Files to Broadcast box. 
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Broadcast Announcement Files - Select Files dialog box 

This dialog box lets you select the announcement files that you want to broadcast to 
other VAL/virtual VAL boards.  

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by performing either of the 
following steps:  

To perform a broadcast now, choose Broadcast from the Actions menu. The Broadcast 
Announcement Files - Select Files dialog box appears. 

To schedule a broadcast task, perform the following steps: 

1 From the Actions menu, choose Scheduler. 

The Task Editor dialog box appears. 

2 Click Add.  

 The Create Task dialog box appears. 

3 Click the Create New Task option button, and click OK.  

 The Create New Task dialog box appears. 

4 Enter the appropriate information, click the Broadcast option button, and then click 
Next.  

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 At the top of the Local Files box, be sure the correct folder is displayed. 

 If it is not, click Select Files to select the folder that has the files you want to 
broadcast. 

2 In the Local Files box, select the files you want to broadcast, and click the > button. If 
you want to broadcast all of the files, click the >> button. 

The files you selected appear in the Selected Files to Broadcast box. 

If you make a mistake, highlight the mistake in the Selected Files to Broadcast box and 
click the < button, or click Cancel to start over. 

3 If you want the files to overwrite the protected announcement files, select the 
Override Protected Bit check box. 

For example, suppose an administered announcement titled hello.wav is present on a 
VAL board 01A05. (Both the audio file and the announcement property for hello.wav are 
present on the VAL board 01A05.) Also, the protected bit for the announcement property 
is set to y (that is, the announcement is protected). 

Now, you try to broadcast hello.wav onto VAL boards, including the VAL board 01A05, 
which already contains the administered announcement hello.wav. If you selected the 
Override Protected Bit check box, the property on VAL board 01A05 will be 
unprotected, hello.wav will be copied, and the property for that announcement will be 
protected again. 
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4 If you want to select extensions to broadcast announcement files to a group of VAL 
sources, perform the following steps: 

a. Select the Broadcast by Ext button. 

The Broadcast Announcement Files – Select Files by Extension dialog box 
appears. 

b. From the Voice System box, select the voice system that contains the extensions 
you want to broadcast. 

c. In the Extension box, enter the extension you want to broadcast, and click Add. 

The VAL board and audio group of the extension you entered appear in the 
Select Files to Broadcast box. 

d.  Repeat Steps B and C for each extension you want to broadcast. 

e. When finished, click OK. 

The Broadcast Announcement Files – Select Files dialog box appears. The VAL board 
and audio group of the selected extensions appear in the Selected Files to Broadcast 
box. 

5 Click one of the following: 

 Next to access the Broadcast Announcement Files - Select Voice System dialog 
box so you can select the destination VAL/virtual VAL board(s). 

 Cancel to ignore the information and close the dialog box. 

 Back to access the previous dialog box. 

 Help for assistance understanding this dialog box. 
 

Broadcast Announcement Files - Select Voice System dialog box 

This dialog box lets you select the VAL/virtual VAL boards to which you want to 
broadcast the announcement files. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by performing either of the 
following steps:  

To perform a broadcast now, perform the following steps: 

1 From the Actions menu, choose Broadcast. 

 The Broadcast Announcement Files – Select Files dialog box appears. 

2 Select the files you want to broadcast from the Broadcast Announcement Files – 
Select Files dialog box, and then click Next.  

To schedule a broadcast task, perform the following steps: 

1 From the Actions menu, choose Scheduler. 

 The Task Editor dialog box appears. 

2 Click Add.  

 The Create Task dialog box appears. 

3 Click the Create New Task option button, and click OK.  

 The Create New Task dialog box appears. 

4 Enter the appropriate information, click the Broadcast option button, and then click 
Next.  

 The Broadcast Announcement Files - Select Files dialog box appears. 
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5 Select the files you want to broadcast from the Broadcast Announcement Files – 
Select Files dialog box, and then click Next.  

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 In the Registered Voice Systems box, select the VAL/virtual VAL boards to which you 
want to broadcast the announcement files, and click the > button. If you want to 
select all of boards, click the >> button. 

The boards you selected appear in the Selected VAL Board box. 

If you make a mistake, highlight the mistake in the Selected VAL Board box and click the 
< button, or click Cancel to start over. 

If you want to broadcast announcement files to extensions, click Broadcast to Ext. The 
Broadcast Announcement Files – Select Boards by Extension dialog box appears. Select 
the destination using an extension on the voice system, and then click Add. The 
corresponding VAL boards and audio groups appear in the Select Boards to Broadcast 
box. You can select multiple extensions on multiple voice systems. When you are 
finished, click OK. The selected boards and audio groups appear in the Selected VAL 
Board box. 

2 If you want to change the name of the file you want to broadcast, click the Change 
Filename to check box, and then enter the new file name in the corresponding box. 
This option is available only when you select a single file for broadcast. 

3 Click one of the following: 

 Next to access the next dialog box. 

 Back displays the previous dialog box. 

 Cancel to ignore the information and close the dialog box. 

 Help for assistance understanding this dialog box. 
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Broadcast Announcement Files - Select Boards by Extension dialog box 

This dialog box lets you select the extensions to which you want to broadcast 
announcement files. You can select multiple extensions on multiple voice systems. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by performing either of the 
following steps:  

To perform a broadcast now: 

1 Choose Broadcast from the Actions menu. 

The Broadcast Announcement Files - Select Files dialog box appears. 

2 Select the Files you want to broadcast, and then click Next. 

 The Broadcast Announcement Files – Select Voice System dialog box appears. 

3 Click Broadcast to Ext. 

Perform the following steps: 

1 From the Actions menu, choose Scheduler. 

The Task Editor dialog box appears. 

2 Click Add.  

 The Create Task dialog box appears. 

3 Click the Create New Task option button, and click OK.  

 The Create New Task dialog box appears. 

4 Enter the appropriate information, click the Broadcast option button, and then 
click Next.  

 The Broadcast Announcement Files – Select Files dialog box appears. 

5 Select the files you want to broadcast, and then click Next. 

 The Broadcast Announcement Files – Select Voice System dialog box appears. 

6 Click Broadcast to Ext. 

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 From the Voice System box, select the voice system that contains the extensions to 
which you want to broadcast. 

2 In the Extension box, enter the extension to which you want to broadcast, and click 
Add. 

The VAL board and audio group of the extension you entered appear in the Select 
Boards to Broadcast box. You can select more than one extension on more than one 
voice system. 

3 Repeat Steps 1 and 2 for each extension to which you want to broadcast.  

4 When finished, click OK. 

The Broadcast Announcement Files – Select Voice System dialog box appears. The VAL 
board and audio group of the selected extensions appear in the Selected VAL Board box. 
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Configure Application Specific E-mail Notification dialog box 

This dialog box lets you configure the Email notification information for Voice 
Announcement Manager. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by selecting Email 
Configuration from the System menu. 

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 In the SMTP Server IP Address/Name box, enter the IP address of the SMTP server. 

2 In the From Address in the Notification E-mail box, enter the email address that you 
want to appear in the From: address for a notification email. 

3 If the outgoing mail server requires authentication, perform the following steps in the 
Outgoing Mail Server area:  

a. Select the My server requires Authentication check box. 

b. In the Login Name box, enter your login name. 

c. In the Password box, enter your password. 

d. In the Re-Enter Password box, re-enter your password. 

4 In the E-mail Event Configuration area, perform one of the following steps:  

 If you want the system to send email when the task is performed successfully, click 
the Send E-mail for Successful Task Completion only option button. 

 If you want the system to send email when the task fails, click the Send E-mail for 
Task Failure only option button. 

 If you want the system to send email when the task is modified or deleted, click the 
Send E-mail when a Task is Modified/Deleted option button. 

 If you want the system to send email when the task is performed successfully, fails, 
or is modified or deleted, click the Send E-mail when any of the Above Events 
Occur option button. 

5 In the Notification Recipient Address area, perform one of the following steps:  

 If you want to add an email address to receive notification, click Add and enter the 
appropriate information. 

 If you want to remove an email address, select that email address and click 
Remove. 

6 Click one of the following: 

 OK to save the information and close the dialog box. 

 Cancel to ignore the information and close the dialog box. 

 Apply to save the information and keep the dialog box open. 

 Test E-mail settings to send an email message to the email addresses listed in the 
Notification Recipient Address area to make sure that the email notification feature 
is administered properly. 

 Help for assistance understanding this dialog box. 
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Configure E-mail Notification dialog box 

This dialog box lets you set 

 the type of event for which email will be sent  

 the email addresses to which email will be sent for the task 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by performing the following 
steps: 

1 From the Actions menu, choose Scheduler. 

 The Task Editor dialog box appears. 

2 Click Add.  

 The Create Task dialog box appears. 

3 Click the Create New Task option button, and click OK.  

 The Create New Task dialog box appears. 

4 Select the Create Task Specific Notification configuration option.  

5 Complete the task-related dialog boxes.  

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 In E-mail Event Configuration area, perform one of the following steps: 

 If you want the system to send email when the task is performed successfully, click 
the Send E-mail for Successful Task Completion only option button. 

 If you want the system to send email when the task fails, click the Send E-mail for 
Task Failure only option button. 

 If you want the system to send email when the task is modified or deleted, click the 
Send E-mail when the Task is Modified/Deleted option button. 

 If you want the system to send email when the task is performed successfully, fails, 
or is modified or deleted, click the Send E-mail when any of the Above Events 
Occurs option button. 

2 In the Notification Recipient Address area, perform one of the following steps:  

 If you want to add an email address to receive notification, click Add and enter the 
appropriate information. 

 If you want to add the default notification email list, click Load. 

 If you want to remove an email address, select that email address and click 
Remove. 

3 Click one of the following: 

 Finish to complete the task and close the dialog box. 

 Back displays the previous dialog box. 

 Cancel to ignore the information and close the dialog box. 

 Help for assistance understanding this dialog box. 
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Connect At Startup dialog box 

This dialog box lets you specify which voice systems you want Voice Announcement 
Manager to connect to automatically when you start Voice Announcement Manager. Only 
the voice systems that you have added to Voice Announcement Manager are displayed. 

Put a check mark in each box next to the name of the systems you want Voice 
Announcement Manager to connect to when it is launched. 

If you want to select all of the voice systems, click the Select All Voice Systems check 
box. 

To remove one from the list of voice systems that Voice Announcement Manager should 
connect to on startup, clear the check box next to that voice system. 

When finished, click OK. 

Copy/Delete Announcement Files dialog box 

This dialog box lets you copy audio files, which may or may not yet be associated with 
announcement properties, from the Voice Announcement Manager computer to a voice 
system or from the voice system to the Voice Announcement Manager computer.  When 
you open this dialog box, Voice Announcement Manager automatically queries the 
appropriate voice system and displays (in the right box) the audio files on that system.  

Note: 
The Copy/Delete Announcement Files dialog box lets you copy ONLY audio files.  
If you want to copy announcement properties, use the Announcement 
Properties table in the right pane of the Voice Announcement Manager main 
window. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

 Right-click a VAL board in the Voice Announcement Manager tree, and then choose 
Copy/Delete Audio Files from the popup menu. 

 Select a VAL board in the Voice Announcement Manager tree, and then choose 
Copy/Delete Audio Files from the Actions menu. 

How do I use this dialog box? 

To use this dialog box to copy files, complete the following steps: 

Tip: 
Check the name displayed at the top of the Files on VAL Board box. If it is not 
the voice system and VAL board that you intended, click Close and then re-
select the appropriate voice system and VAL board from the Voice 
Announcement Manager Tree.  Also check the name displayed at the top of the 
Files From Local PC box.  If it is not the folder you intended, click Change 
Folder and navigate to the correct one. 
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1 Select files and move them to the appropriate box. 

 To copy audio files to the voice system, select an audio file in the Files From Local 
PC box and use the > button to move it to the Files on VAL Board box. 

 To copy audio files from the voice system, select an audio file in the Files on VAL 
Board box and use the < button to move it to the Files From Local PC box. 

Note: 
When you select an audio file from the Files on VAL Board box (the voice 
system) and move it to the Files From Local PC box (the Voice Announcement 
Manager computer) beware that you could be overwriting backup files on the 
Voice Announcement Manager computer.   

 Shift-click or Ctrl-click to select more than one file in a box. 

 Click >> or << to move all of the files from one box to the other. 

 If you moved something from the Files on VAL Board box to the Files From Local 
PC box mistakenly, go to your Windows Explorer and delete the file. If you moved 
something from the Files From Local PC box to the Files on VAL Board box by 
mistake, highlight it in the Files on VAL Board box and click the Delete File button.  

2 While copying audio files to the VAL board, if you want to override the protected bit, 
select the Override Protected Bit check box. 

For example, suppose an administered announcement titled hello.wav is present on a 
VAL board 01A05. (Both the audio file and the announcement property for hello.wav are 
present on the VAL board 01A05.) Also, the protected bit for the announcement property 
is set to y (that is, the announcement is protected). 

Now, you try to copy hello.wav onto VAL boards, including the VAL board 01A05, which 
already contains the administered announcement hello.wav. If you selected the 
Override Protected Bit check box, the property on VAL board 01A05 will be 
unprotected, hello.wav will be copied, and the property for that announcement will be 
protected again. 

3 Click one of the following: 

 Close to close this dialog box. 

 Help for assistance understanding this dialog box. 

To use this dialog box to delete files, complete the following steps: 

1 In the Files on VAL Board box, select the files you want to delete from the VAL/virtual 
VAL board. 

2 Click Delete File. 

 A confirmation dialog box appears prompting whether you want to delete the 
corresponding announcement property.  

3 Perform one of the following steps: 

 If you want to delete the announcement property also, click Yes. 

 If you do not want to delete the announcement property, click No. 

4 Click Yes to delete the audio file. 

 Voice Announcement Manager deletes the selected audio file from the VAL board. 

5 Click one of the following: 

 Close to close this dialog box. 

 Help for assistance understanding this dialog box. 
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Create/Edit Group dialog box 

This dialog box lets you  

 Create a new audio group. 

 Modify an existing audio group. 

 Delete an audio group. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by performing one of the 
following steps: 

 Right-click an audio group in the Voice Announcement Manager tree, and then choose 
Create/Edit Group from the popup menu. 

 Select an audio group in the Voice Announcement Manager tree, and then choose 
Create/Edit Group from the Actions menu. 

How do I use this dialog box? 

If you want to create a new audio group, complete the following steps: 

1 Click the Create New Group option button. 

2 From the Group No. box, select the number for this group. 

3 In the Group Name box, enter the name for this group. 

4 In the Available Announcement Sources box, select the announcement sources you 
want to add to this group, and click the > button. If you want to add all of the 
announcement sources, click the >> button. 

The announcement sources you selected appear in the Group Members box. 

If you make a mistake, highlight the mistake in the Group Members box and click the < 
button, or click Cancel to start over. 

5 Click OK. 

After the group is created, the Create Group Task dialog box appears. 

If you want to modify an existing audio group, complete the following steps: 

1 Click the Edit Group option button. 

2 From the Group No. box, select the number of the group you want to modify. 

The information for the selected group appears. 

3 Make your changes. 

4 When finished, click OK. 

After the group is modified, the Edit Group Task dialog box appears. 

If you want to delete an audio group, complete the following steps: 

1 Click the Edit Group option button. 

2 From the Group No. box, select the number of the group you want to delete. 

The information for the selected group appears. 

3 Click Delete. 

A warning dialog box appears. 

4 Click Yes to delete the group. 

After the group is deleted, the Delete Group Task dialog box appears. 
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Create New Task dialog box 

This dialog box lets you create a new task that will perform one of the following actions: 

 back up selected VAL boards  

 back up all voice systems 

 broadcast announcements 

 import voice announcement properties from a comma-separated values (CSV) file and 
send that data to a voice system 

 export voice announcement properties from a voice system to a comma-separated 
values (CSV) file 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by performing the following 
steps:  

1 From the Actions menu, choose Scheduler. 

 The Task Editor dialog box appears. 

2 Click Add.  

 The Create Task dialog box appears. 

3 Click the Create New Task option button, and click OK.  

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 In the Name box, enter the name or description for this task. 

2 In the Create New area, perform one of the following steps:  

 If you want to create a task that will back up selected VAL boards, click the Backup 
option button, and then click the Backup Selected VAL Boards option button. 

 If you want to create a task that will back up all voice systems, click the Backup 
option button, and then click the Backup All Voice Systems option button. 

 If you want to create a task that will broadcast announcements, click the Broadcast 
option button. 

 If you want to create a task that will import voice announcement properties from a 
CSV file and send that data to a voice system, click the Import option button. 

 If you want to create a task that will export voice announcement properties from a 
voice system to a CSV file, click the Export option button. 

3 In the E-mail Notification area, perform one of the following steps:  

 If you want the system to send email to the default email address you specified 
when the task is performed, click the Use Default Notification Configuration 
option button. 

 If you want the system to send email to a specific email address (that is, an email 
address other than the default) when the task is performed, click the Create Task 
Specific Notification Configuration option button. 

 If you do not want the system to send email when the task is performed, click the 
Do Not Send Notification option button. 

4 If you want to use this task as a template, select the Save this Task for use as a 
Template check box.  
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5 Click one of the following: 

 Next to access the next dialog box and close this dialog box 

 Cancel to ignore this information and close the dialog box. 

 Help for assistance understanding this dialog box. 
 

Create Task dialog box 

This dialog box lets you: 

 create a new task using a template that you created previously 

 create a new task without using a template 

 delete an existing template 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by performing the following 
steps:  

1 From the Actions menu, choose Scheduler. 

 The Task Editor dialog box appears. 

2 Click Add.  

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 Perform one of the following steps: 

 If you want to create a new task without using a template, click the Create New 
Task option button.  

 If you want to create a new task using a template, click the Use Template option 
button, and then select a template from the list box. 

 If you want to delete a template, click the Use Template option button, select the 
template you want to delete from the list box, and click Delete. 

2 Click OK.  
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Create Template dialog box 

This dialog box lets you create a new template that will perform one of the following 
actions: 

 back up selected VAL boards  

 back up all voice systems 

 broadcast announcements 

 import voice announcement properties from a comma-separated values (CSV) file and 
send that data to a voice system 

 export voice announcement properties from a voice system to a comma-separated 
values (CSV) file 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by performing the following 
steps: 

1 From the Actions menu, choose Template Editor. 

 The Template Editor dialog box appears. 

2 Click Add.  

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 In the Name box, enter the name for this template. 

2 In the Create New area, perform one of the following steps:  

 If you want to create a template that will back up selected VAL boards, click the 
Backup option button, and then click the Backup Selected VAL Boards option 
button. 

 If you want to create a template that will back up all voice systems, click the 
Backup option button, and then click the Backup All Voice Systems option button. 

 If you want to create a template that will broadcast announcements, click the 
Broadcast option button. 

 If you want to import voice announcement properties from a CSV file and send that 
data to a voice system, click the Import option button. 

 If you want to export voice announcement properties from a voice system to a CSV 
file, click the Export option button. 

3 In the E-mail Notification area, perform one of the following steps:  

 If you want the system to send email to the default email address you specified 
when the task is performed, click the Use Default Notification Configuration 
option button. 

 If you want the system to send email to a specific email address (that is, an email 
address other than the default) when the task is performed, click the Create Task 
Specific Notification Configuration option button. 

 If you do not want the system to send email when the task is performed, click the 
Do Not Send Notification option button. 

4 If you do not want this task to be scheduled, click the Template only: Do not 
schedule check box. 
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5 Click one of the following: 

 Next to access the next dialog box and close this dialog box 

 Cancel to ignore this information and close the dialog box. 

 Help for assistance understanding this dialog box. 

When you complete the template, you will have the option of creating a task from this 
new template (that is, a task with the same properties as the template can be created). 

 

Edit Application Properties dialog box 

This dialog box lets you configure the following system settings for Voice Announcement 
Manager: 

 the maximum file size for the activity log. By default, the file size for the activity log 
is 1 MB. If the file size reaches the limit you set, the file val_status.txt will be 
copied to the file val_status.txt.old, and Voice Announcement Manager will start 
logging messages in the new val_status.txt file. If the file val_status.txt.old 
already exists, that file will be overwritten. 

 the maximum number of threads spawned per voice system at a time. The threads 
perform FTP operation on a VAL board. By default, the value for this property will 
be 10. 

 the FTP mode (ACTIVE or PASSIVE). By default, the FTP mode is ACTIVE. 

 the number of messages to be displayed in the Status pane. By default, 51 
messages will be displayed in the Status pane. 

 the editing software you want to use to view the activity log. The default editor is 
WordPad.  

 the audio player/editor software you want Voice Announcement Manager to start 
when you select Launch Audio player/Editor from the File menu.  

 the maximum number of minutes that you want Voice Announcement Manager to 
maintain its connection to the voice system.  

 the maximum number of seconds that you want Voice Announcement Manager to 
maintain its connection to the voice system after the last communication to the 
voice system.  

 the number of seconds that you want to elapse before Voice Announcement 
Manager logs into a voice system. This delay is the number of seconds that elapse 
from when you request information from the voice system to when Voice 
Announcement Manager logs into that voice system. 

 whether you have to log into Voice Announcement Manager via a password. You 
can set Voice Announcement Manager to prompt you for a password every time 
you start Voice Announcement Manager. If you password protect Voice 
Announcement Manager, you must also specify an email address so Voice 
Announcement Manager can email you a copy of your password on request (for 
example, if you forget your password).  
 
If you enter the wrong password five consecutive times, Voice Announcement 
Manager will close. If you are unable log into Voice Announcement Manager (that 
is, you cannot remember your password), you must delete the file "ValManager.dat" 
and then start Voice Announcement Manager. Your tasks, templates, and other 
settings are preserved, but all of the voice system information is removed. You must 
re-enter the voice system information. 
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NOTE: 
If you want to password protect Voice Announcement Manager, you must first 
configure the outgoing mail server information for Voice Announcement Manager.  

 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by selecting Edit 
Application Properties from the File menu. 

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 In the Log Limit (in MB) box, enter the maximum file size for the activity log. The 
range is 1 to 5 MB. 

2 In the FTP Thread Limit box, enter the maximum number of threads spawned per 
voice system at a time. The range is 1 to 25. 

3 From the FTP Connect Mode box, select the FTP mode. The default is ACTIVE. 

4 In the Status Pane Messages box, enter the maximum number of messages to be 
displayed in the Status pane. The range is 1 to 250. 

5 From the Log Editor box, select the editing software that will be used to view the 
activity log. 

6 From the Audio Player/Editor box, select the audio player/editor software you want 
Voice Announcement Manager to start when you select Launch Audio 
player/Editor from the File menu. 

7 In the Login Duration box, enter the maximum number of minutes that you want 
Voice Announcement Manager to maintain its connection to the voice system. 

8 In the Connection Timeout box, enter the maximum number of seconds that you want 
Voice Announcement Manager to maintain its connection to the voice system after 
the last communication to the voice system. 

9 In the Login Delay box, enter the number of seconds that must elapse before Voice 
Announcement Manager logs into a voice system. This delay is the number of 
seconds that elapse from when you request information from the voice system to 
when Voice Announcement Manager logs into that voice system. 

10 If you want to configure Voice Announcement Manager to prompt you for a password 
when you start Voice Announcement Manager, perform the following steps: 

a. Click the Authentication Required check box. 

b. In the Password box, enter the password you want to use to log into Voice 
Announcement Manager. 

c. In the Re-enter Password box, enter the password you want to use to log into 
Voice Announcement Manager. 

d. In the E-mail ID box, enter the email address to which you want Voice 
Announcement Manager to email your password. This setting is valuable if you 
forget your password. 

11 Click Save. 
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NOTE: 
If you tried to configure a password for Voice Announcement Manager, but you did not 
configure the outgoing mail server information for Voice Announcement Manager 
previously, an error message appears. Perform the following steps: 

1 Click OK to close the error message box. 

2 Uncheck the Authentication Required check box. 

3 Configure the outgoing mail server information for Voice Announcement Manager. 

4 Perform Steps 10 and 11 in this procedure to password protect Voice Announcement 
Manager. 

 

Edit Voice System Properties dialog box 

This dialog box lets you view or change the information that Voice Announcement 
Manager needs about a voice system. 

Voice System Name 
Enter the name of the voice system you want Voice Announcement Manager to support. 

FQDN or IP Address 
Enter the IP Address of the C-LAN board that you want to use to connect to this voice 
system. There may be many C-LAN boards on your voice system; you need to know 
which one you are using for administration. If you don’t know it, you can ask your 
LAN/WAN administrator, or you can get this information from the voice system. 

Port 
Enter the number of the IP Network Port that this voice system’s C-LAN board will be 
using to communicate with Voice Announcement Manager. If you don’t know it, you can 
ask your LAN/WAN administrator or you can get this information from the voice system. 

Login Name 
Enter the Login Name of the account on the voice system that you want Voice 
Announcement Manager to use to access this voice system. 

Password 
If this voice system uses a password, select this option button and enter the password 
associated with the Login Name you specified in the previous field. 

Access Security Gateway (ASG) 
ASG is an optional security feature available on your voice system. Select this option 
button only if this voice system uses ASG and if this login uses ASG. Then, enter the 
ASG Secret Key associated with the login you entered in the Login Name field. 

Companding Mode 
This display-only field does not appear for voice systems you are first adding. This field 
appears only for voice systems you have already added to Voice Announcement Manager, 
and displays data that has been retrieved from the voice system. Companding Mode 
indicates the method by which the signal will be compressed for economical transmission 
and then decompressed at the receiving end. 

Connect At Startup 
Put a check in this box if you want Voice Announcement Manager to attempt to connect 
to this voice system automatically when you start Voice Announcement Manager. 

Use SSH 
Put a check in this box if you want Voice Announcement Manager to make a secure 
connection to this voice system. When you select this feature, the copy and FTP operations 
will also be secured, and the port is changed to 5022.  
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If you select the Use SSH check box, the SSH Configuration tab appears. 

Authentication Method 
Choices are Password or ASG. 

Public Key 
Choices are ssh-dsa or ssh-rsa. 

Key Exchange Method  
Choice is diffie-hellman-group1-sha1. 

Cipher  
Choices are blowfish-cbc, 3DES-CBC, or AES. 

MAC 
Choices are hmac-md5, hmac-md5-96, hmac-sha1, or hmac-sha1-96. 

Use SFTP 
Put a check in this box if you want Voice Announcement Manager to use secure FTP to 
transfer WAV files to and from TN2501 VAL sources. 

Use SCP 
Put a check in this box if you want Voice Announcement Manager to use secure SCP to 
transfer WAV files. If you select this check box, the SCP Configuration tab appears. 
NOTE: 
SCP is only supported on G350, G250, G250-DCP, and G250-DS1 media gateways. 

User Name 
Enter the login on the media gateway. 

Security Model 
Choices are Authentication, Privatization; Authentication, No Privatization; and No 
Authentication, No Privatization. 

Authentication Password 
Enter the password for the media gateway login. 

Privacy Password 
Enter the password. 

Apply data above to all boards 
Put a check in this box if you want to use this information for all boards. 

Apply data above to selected 
Put a check in this box if you want to use this information for selected boards. If you 
select this check box, you must click the Boards for SCP tab, select the appropriate 
boards, and then click the Apply Now button. 
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Edit VAL Board Properties dialog box 

This dialog box displays (for the VAL board that you selected) the values from the 
following Communication Manager fields.  

 

Field Description 

Location Slot location of the VAL board 

Name Node name of the VAL board 

Type The Media Gateway type (for example, G700 or G350) 

IP Address IP address of the VAL board 

Time Remaining Time remaining to record on the VAL board 

Audio Files Folder Location where audio files will be stored on the computer. 

If the media gateway is a G350, G250, G250-DCP, or G250-DS1, the media gateway 
SNMPv3 credentials that you entered in the SCP Configuration tab in the Register/Edit 
Voice System Properties dialog box are also displayed.  

Export Data - Filters dialog box 

This dialog box lets you select the data that you want to retrieve from a voice system and 
export that information to a file. For example, you may want to retrieve a list of all 
announcement properties that have a class restriction of 1. 

Using this dialog box, you specify the range of values you want to retrieve. You can 
specify lists, such as 1000-1999,2000,2002-2010. For example, if you want a list of all 
announcements with extensions from 1000 to 2000, you would enter 1000-2000 in the 
Extension field. 

About wildcards, ranges and delimiters 

Wildcard, ranges, and delimiters are useful when you are specifying a range of criteria, 
such as for changing certain object data. 

Wildcards (? and *)  
Wildcards are used to match non-numeric values. The ? character matches any one 
character. The * character matches zero or more characters.  

Example:  The filter 01?01* will match 01A01, 01A0101, 01B0115 and 01D01.  The filter 
01?01* will not match 0101, 02A0101 or 01AA01. 

Ranges 
Ranges are used to match numbers that fall within a range, or characters that come 
within a range. Character ranges are specified within square brackets. 

Example:  The filter 100-200 will match any numeric value between 100 and 200.The 
filter 01[A-B]* will match any string beginning with 01A or 01B. 

Delimiters 
Sometimes you will need to match something that looks like a range or wildcard, but is 
not. You will need to surround the filter in quotes so that it is not misinterpreted. 

Example:  "01[A-B]*" matches the string 01[A-B]* exactly, but it will not match the string 
01A01. 
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How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

 Right-click the voice system in the Voice Announcement Manager tree, and then 
choose Export Announcement Properties from the popup menu. 

 Select the voice system in the Voice Announcement Manager tree, and then choose 
Export Announcement Properties from the System menu. 

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 In the Value box for the field in which you are interested, enter the value you want to 
export from the voice system. You may enter wildcard characters. 

2 Repeat Step 1 for any other fields in which you are interested.  

3 Click one of the following: 

 Next to access the next dialog box. 

 Cancel to abort the export and close the dialog box. 

 Help for assistance understanding this dialog box. 

 

Export Data - Fields dialog box 

This dialog box lets you select the fields you want to export from the selected voice 
system. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

1 Perform one of the following steps: 

 Right-click the voice system in the Voice Announcement Manager tree, and then 
choose Export Announcement Properties from the popup menu. 

 Select the voice system in the Voice Announcement Manager tree, and then 
choose Export Announcement Properties from the System menu. 

 The Export Data – Filters dialog box appears. 

2 Enter the appropriate information in the Export Data – Filters dialog box, and then 
click Next.  

 The Export Data – Fields dialog box appears. 

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 In the Available fields box, select the field you want to export from the voice system. 

2 Click the > button.  

The field you selected appears in the Selected fields in record order box. 

Repeat steps 1 and 2 for each field you want to export. If you want to export all of the 
fields, click the >> button. 
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3 Click one of the following: 

 Next to access the next dialog box. 

 Back to access the previous dialog box. 

 Cancel to abort the export and close the dialog box. 

 Help for assistance understanding this dialog box. 
 

Export Data - Announcement Properties dialog box 

This dialog box lets you specify  

 the name of the CSV file to which voice announcement properties will be exported. 

 whether the table header information will be exported to the CSV file. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

1 Perform one of the following steps: 

 Right-click the voice system in the Voice Announcement Manager tree, and then 
choose Export Announcement Properties from the popup menu. 

 Select the voice system in the Voice Announcement Manager tree, and then 
choose Export Announcement Properties from the System menu. 

 The Export Data – Filters dialog box appears. 

2 Enter the appropriate information in the Export Data – Filters dialog box, and then 
click Next.  

 The Export Data – Fields dialog box appears. 

3 Enter the appropriate information in the Export Data – Fields dialog box, and then 
click Next.  

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 In the Export File box, enter the path and name for the CSV file to which you will 
export the data. 

2 Select the Export Table Header check box if you want to export the table header 
information to the CSV file.  

 The Sample Export box shows the first several lines of data that will be exported. 

3 Click one of the following: 

 Next to access the Export Data – Summary dialog box and complete this task. 

 Back to close the dialog box and display the Export Data – Fields dialog box. 

 Cancel to abort the export and close the dialog box. 

 Help for assistance understanding this dialog box. 
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Export Data - Summary dialog box 

This dialog box describes the task that will be performed and lets you complete the task. 

How do I use this dialog box? 

To use this dialog box, perform one of the following steps: 

 To complete the task, click Finish. 

 To schedule this task, click Schedule this task and then set the time and frequency. 

 To access the previous dialog box, click Back. 

 To abort the task and close the dialog box, click Cancel. 

 To get assistance understanding this dialog box, click Help. 
 

Import Announcement Properties Wizard dialog box 

This dialog box lets you specify 

 the CSV file you will import. 

 how the announcement properties from the CSV file will be added to the voice system. 

 whether the first row of data from the CSV file will be imported. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

1 Perform one of the following steps: 

 Right-click the voice system in the Voice Announcement Manager tree, and then 
choose Import Announcement Properties from the popup menu. 

 Select the voice system in the Voice Announcement Manager tree, and then 
choose Import Announcement Properties from the System menu. 

 The Import Data - Select Announcement Fields dialog box appears. 

2 Enter the appropriate information in the Import Data - Select Announcement Fields 
dialog box, and then click Next.  

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 Click Select. 

 The Open dialog box appears. 

2 Select the CSV file you want to import, and click Open.  

 If you want to view a sample file that is set up correctly, click View Sample.  

3 Perform one of the following steps: 

 If you want to add the announcement properties from the selected file to the 
voice system, select Add.  

 If you want to change the fields of the existing announcement properties on the 
voice system with the fields in the selected file, select Change. 

 If you want to delete all of the announcement properties on the voice system that 
correspond with the announcement properties in the selected file, select Delete. 

4 If you do not want to import the first row of data from the CSV file, click Yes.  
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5 Click one of the following: 

 Next to access the Import Data - Summary dialog box and import the selected file. 

 Back to close the dialog box and display the Import Data – Select Announcement 
Fields dialog box. 

 Cancel to abort the import and close the dialog box. 

 Help for assistance understanding this dialog box. 
 

Import Data - Select Announcement Fields dialog box 

This dialog box lets you select the fields you want to import from a CSV file. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

 Right-click the voice system in the Voice Announcement Manager tree, and then 
choose Import Announcement Properties from the popup menu. 

 Select the voice system in the Voice Announcement Manager tree, and then choose 
Import Announcement Properties from the System menu. 

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 In the Available fields box, select the field you want to import from the source file. 

2 Click the > button.  

The field you selected appears in the Selected fields in record order box. 

Repeat steps 1 and 2 for each field you want to import. If you want to import all of the 
fields, click the >> button. 

NOTE: 
If the COR, TN, Queue, Protect, Rate, or Port fields are blank, the defaults for these 
settings on the voice system will be used for the imported announcement properties. 

3 Click one of the following: 

 Next to access the next dialog box and make changes to the selected file. 

 Back to access the previous dialog box. 

 Cancel to abort the import and close the dialog box. 

 Help for assistance understanding this dialog box. 
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Import Data - Summary dialog box 

This dialog box lets you  

 modify the CSV file that you want to import. 

 schedule this import. 

 import the CSV file. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

1 Perform one of the following steps: 

 Right-click the voice system in the Voice Announcement Manager tree, and then 
choose Import Announcement Properties from the popup menu. 

 Select the voice system in the Voice Announcement Manager tree, and then 
choose Import Announcement Properties from the System menu. 

 The Import Data - Select Announcement Fields dialog box appears. 

2 Enter the appropriate information in the Import Data - Select Announcement Fields 
dialog box, and then click Next.  

 The Import Announcement Properties Wizard dialog box appears. 

3 Enter the appropriate information in the Import Announcement Properties Wizard 
dialog box, and then click Next.  

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 If you want to make changes to the selected file, click View\Edit Import File, and 
make your changes. 

2 If you want to schedule this import, click Schedule this task and specify the 
frequency. 

3 Click one of the following: 

 Finish to import the selected file. 

 Back to close the dialog box and display the Import Announcement Properties 
Wizard dialog box. 

 Cancel to abort the import and close the dialog box. 

 Help for assistance understanding this dialog box. 
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Move Announcement Files - Select Destination VAL Board dialog box 

This dialog box lets you select the VAL/virtual VAL board to which you want to move the 
selected announcement. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by: 

1 Perform one of the following steps: 

 Right-click a VAL/virtual VAL board in the Voice Announcement Manager tree, and 
then choose Move Audio Files from the popup menu.  

 Select a VAL/virtual VAL board in the Voice Announcement Manager tree, and then 
choose Move Audio Files from the Actions menu. 

 The Move Announcement Files - Select Files To Move dialog box appears. 

2 Enter the appropriate information in the Move Announcement Files - Select Files To 
Move dialog box, and then click Next.  

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 At the top of the VAL Boards On box, be sure the correct voice system is displayed. 

 If it is not, click Cancel and start over, being sure to select the correct voice system 
first. 

2 In the VAL Boards On box, highlight the VAL/virtual VAL board to which you want to 
move the announcement. (This is the destination VAL/ virtual VAL board.) You can 
only select one VAL/virtual VAL board at a time.  

3 If you want to override the protected bit, click the Override Protected bit check box.  

4 Click the > button.  

The VAL/virtual VAL board you selected appears in the Destination VAL Board box. 

If you make a mistake, highlight the mistake in the Destination VAL Board box and click 
the < button, or click Cancel to start over. 

5 Click one of the following: 

 Finish to move the announcement and close the dialog box 

 Back to close the dialog box and display the Move Announcement Files - Select 
Files to Move dialog box. 

 Cancel to abort the moving of the announcement and close the dialog box. 

 Help for assistance understanding this dialog box. 
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Move Announcement Files - Select Files To Move dialog box 

This dialog box lets you select the announcement that you want to move from a 
VAL/virtual VAL board to another VAL/virtual VAL board on the same voice system. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

 Right-click a VAL/virtual VAL board in the Voice Announcement Manager tree, and then 
choose Move Audio Files from the popup menu. 

 Select a VAL/virtual VAL board in the Voice Announcement Manager tree, and then 
choose Move Audio Files from the Actions menu. 

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 At the top of the File on VAL Board box, be sure the correct voice system is 
displayed. 

 If it is not, click Cancel and start over, being sure to select the correct voice system 
first. 

2 In the File on VAL Board box, highlight the announcement that you want to move to 
another VAL/virtual VAL board. You can only move one announcement at a time.  

3 If you want to move the associated announcement property for the selected 
announcement, click the Move Associated Announcement Property check box.  

4 Click the > button.  

The announcement you selected appears in the File To Be Moved box. 

If you make a mistake, highlight the mistake in the right box and click the < button, or 
click Cancel to start over. 

5 Click one of the following: 

 Next to access the Move Announcement Files - Select Destination VAL Board 
dialog box so you can select the destination VAL/virtual VAL board. 

 Cancel to abort the moving of the announcement and close the dialog box. 

 Help for assistance understanding this dialog box. 
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Move Announcement Properties dialog box 

This dialog box lets you select the announcement administration/properties (and the 
associated announcement file) you want to move from one VAL board to another on the 
same voice system. In this procedure, the selected announcement 
administration/properties are copied to the destination VAL board and deleted from the 
source VAL board. 

How can I view this window? 

If you aren’t viewing this dialog box already, you can access it by performing the following 
steps: 

1 Right-click the appropriate VAL board in the Voice Announcement Manager Tree and 
select Move Announcement Properties.  

How do I use this window? 

To use this window, complete the following steps: 

1 Select the check box for each announcement property you want to move. 

2 From the Move to board box, select the VAL board to which you want to move the 
selected announcement properties. 

3 If you want to move the associated audio file, select the Move Associated Audio 
File check box. 

NOTE: 
The Move Associated Audio File check box will be enabled only if the 
corresponding audio file is present on the VAL board. 

4 If you want to override the protected bit, make sure the Override Protected Bit 
check box is selected. 

5 Click one of the following: 

 OK to move the selected announcement properties and close the window. 

 Cancel to abort the procedure and close the window. 

 Help for assistance understanding this window. 
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Move Announcement Property dialog box 

This dialog box lets you move the announcement administration/property (and the 
associated announcement file) from one VAL board to another on the same voice 
system. In this procedure, the announcement administration/property is copied to the 
destination VAL board and deleted from the source VAL board. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by performing the following 
steps: 

1 Right-click the appropriate VAL board in the Voice Announcement Manager Tree and 
select View Announcement Properties.  

 Voice Announcement Manager displays the Announcement Properties table in the 
right pane. 

2 Right-click the announcement you want to move, and then choose Move from the 
popup menu. 

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 From the Select Destination VAL Board box, select the VAL board to which you want 
to move the announcement property. 

2 If you want to move the associated audio file, select the Move Associated Audio 
File check box. 

NOTE: 
The Move Associated Audio File check box will be enabled only if the 
corresponding audio file is present on the VAL board. 

3 If you want to override the protected bit, make sure the Override Protected Bit 
check box is selected. 

4 Click one of the following: 

 OK to move the announcement property and close the dialog box. 

 Cancel to abort the procedure and close the dialog box. 

 Help for assistance understanding this dialog box. 
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Register Voice System dialog box 

This dialog box enables you to add a voice system to Voice Announcement Manager. 

Voice System Name 
Enter the name of the voice system you want Voice Announcement Manager to support. 

FQDN or IP Address 
Enter the IP Address of the C-LAN board that you want to use to connect to this voice 
system. There may be many C-LAN boards on your voice system; you need to know 
which one you are using for administration. If you don’t know it, you can ask your 
LAN/WAN administrator, or you can get this information from the voice system. 

Port 
Enter the number of the IP Network Port that this voice system’s C-LAN board will be 
using to communicate with Voice Announcement Manager. If you don’t know it, you can 
ask your LAN/WAN administrator or you can get this information from the voice system. 

Login Name 
Enter the Login Name of the account on the voice system that you want Voice 
Announcement Manager to use to access this voice system. 

Password 
If this voice system uses a password, select this option button and enter the password 
associated with the Login Name you specified in the previous field. 

Access Security Gateway (ASG) 
ASG is an optional security feature available on your voice system. Select this option 
button only if this voice system uses ASG and if this login uses ASG. Then, enter the 
ASG Secret Key associated with the login you entered in the Login Name field. 

Companding Mode 
This display-only field does not appear for voice systems you are first adding. This field 
appears only for voice systems you have already added to Voice Announcement Manager, 
and displays data that has been retrieved from the voice system. Companding Mode 
indicates the method by which the signal will be compressed for economical transmission 
and then decompressed at the receiving end. 

Connect At Startup 
Put a check in this box if you want Voice Announcement Manager to attempt to connect 
to this voice system automatically when you start Voice Announcement Manager. 

Use SSH 
Put a check in this box if you want Voice Announcement Manager to make a secure 
connection to this voice system. When you select this feature, the copy and FTP operations 
will also be secured, and the port is changed to 5022.  

If you select the Use SSH check box, the SSH Configuration tab appears. 

Authentication Method 
Choices are Password or ASG. 

Public Key 
Choices are ssh-dsa or ssh-rsa. 

Key Exchange Method  
Choice is diffie-hellman-group1-sha1. 

Cipher  
Choices are blowfish-cbc, 3DES-CBC, or AES. 
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MAC 
Choices are hmac-md5, hmac-md5-96, hmac-sha1, or hmac-sha1-96. 

Use SFTP 
Put a check in this box if you want Voice Announcement Manager to use secure FTP to 
transfer WAV files to and from TN2501 VAL sources. 

Use SCP 
Put a check in this box if you want Voice Announcement Manager to use secure SCP to 
transfer WAV files. If you select this check box, the SCP Configuration tab appears. 

NOTE: 
SCP is only supported on G350, G250, G250-DCP, and G250-DS1 media gateways. 

User Name 
Enter the login on the media gateway. 

Security Model 
Choices are Authentication, Privatization; Authentication, No Privatization; and No 
Authentication, No Privatization. 

Authentication Password 
Enter the password for the media gateway login. 

Privacy Password 
Enter the password. 

Apply data above to all boards 
Put a check in this box if you want to use this information for all boards. 

Apply data above to selected 
Put a check in this box if you want to use this information for selected boards. If you 
select this check box, you must click the Boards for SCP tab, select the appropriate 
boards, and then click the Apply Now button. 

 

Rename Announcement Property dialog box 

This dialog box lets you rename the selected announcement property. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by selecting Edit 
Application Properties from the File menu. 

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 In the New Property Name box, enter the new name for the announcement property. 

2 If you want to rename the associated audio file, click the Rename Associated Audio 
File check box. 

3 If you want to override the protected bit, click the Override Protected Bit check box. 

4 Click OK. 
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Rename Audio File dialog box 

This dialog box lets you rename the selected audio file. 

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 In the New Audio File Name box, enter the new name for the audio file. 

2 If you want to rename the associated announcement property, click the Rename 
Associated Announcement Property check box. 

3 If you want to override the protected bit, click the Override Protected Bit check box. 

4 Click OK. 

 

Restore Audio Files and Announcements Properties dialog box 

This dialog box lets you restore your announcement files and announcement property 
files from a location on your Voice Announcement Manager computer to a VAL/virtual 
VAL board you select. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

 Right-click a VAL board in the Voice Announcement Manager tree, and then choose 
Restore from the popup menu. 

 Select a VAL board in the Voice Announcement Manager tree, and then choose 
Restore from the Actions menu. 

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 At the top of the Files From Local PC box, be sure the location that contains the files 
you want to restore is displayed. 

 If it is not, click Change Folder and select the location where the files should come 
from. 

2 At the top of the Selected Files to Restore box, be sure the correct VAL/virtual VAL 
board is displayed. 

 If it is not, click Cancel and start over, being sure to select the correct VAL board 
first. 

3 In the Files From Local PC box, highlight the announcements that you want to restore 
and click the > button. 

The prefix "AF" indicates that both the announcement property and the .wav file are 
present for that announcement. Prefix "F" indicates that only .wav file is present and 
prefix "A" indicates that only announcement property file is present. 

If you make a mistake, highlight the mistake in the right box and click the < button, or 
click Cancel to start over. 

4 Repeat Step 3 until you have specified all of the announcements that you want to 
restore from the Voice Announcement Manager computer. 

5 If you want the announcement you are restoring to override the existing 
announcement on that board, click the Override Protected Bit check box: 
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6 Click one of the following: 

 OK to execute the restore and close the dialog box 

 Apply to execute the restore and leave the dialog box open. 

 Cancel to abort the restore and close the dialog box. 

 Help for assistance understanding this dialog box. 
 

SCP Server Configuration dialog box 

This dialog box lets you view or change the information for the SCP server.  

NOTE: 
SCP is only supported on G250 and G350 media gateways. 

Local 
Select this option button if the SCP server is installed on the local PC. 

Remote 
Select this option button in the SCP server is installed on a different PC. 

IP Address 
Enter the IP address of the SCP server. If you selected the Local option button, the IP 
address of the local PC appears. 

Login 
Enter the login for an account on the SCP server. 

Password 
Enter the password associated with the login you entered in the Login box. 

Home Directory 
Enter the path for the home directory. Use the Browse button to select this directory. 
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Search and Replace VAL Sources dialog box 

This dialog box lets you: 

 find VAL sources in an audio group in a voice system 

 replace VAL sources in an audio group in a voice system 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

 Right-click the voice system in the Voice Announcement Manager tree, and then 
choose Search/Replace VAL Sources in Group from the popup menu. 

 Select the voice system in the Voice Announcement Manager tree, and then choose 
Search/Replace VAL Sources in Group from the Actions menu. 

How do I use this dialog box? 

To find a VAL source, complete the following steps: 

1 Click the Find option button. 

2 In the Available VAL Sources box, select the VAL source you want to find and click 
the > button.  

The VAL source you selected appears in the VAL Sources to be searched box. 

3 Click OK. 

The Search Results for groups dialog box appears and displays the number and name of 
the group that contains this VAL source. 

To find and replace a VAL source, complete the following steps: 

1 Click the Find and Replace option button. 

2 In the Available VAL Sources box, select the VAL source you want to find and 
replace, and click the > button.  

The VAL source you selected appears in the VAL Sources to be searched box. 

3 Click Next. 

4 In the Available VAL Sources box, select the VAL source you want to use as the 
replacement, and click the > button.  

The VAL source you selected appears in the VAL Sources to be replaced box. 

5 Click Finish. 

The Search and Replace VAL Sources Success dialog box appears. 

6 Click Close. 
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Search Results dialog box 

This dialog box displays the results of your search for announcement property files or 
audio files on a voice system. 

If you performed a search for announcement property files, you can: 

 Move announcement properties 

 Edit announcement properties 

 Rename announcement properties 

 Delete announcement properties 

 Print announcement properties 

If you performed a search for audio files, you can: 

 Move audio files 

 Copy audio files 

 Rename audio files 

 Delete audio files 

 Print audio files 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

1 Perform one of the following steps: 

 Right-click Voice Systems in the Voice Announcement Manager tree, and then 
choose Search Announcement Property/File from the popup menu. 

 Select Voice Systems in the Voice Announcement Manager tree, and then choose 
Search Announcement Property/File from the System menu. 

 Right-click a voice system in the Voice Announcement Manager tree, and then 
choose Search Announcement Property/File from the popup menu. 

 Select a voice system in the Voice Announcement Manager tree, and then choose 
Search Announcement Property/File from the System menu. 

 The Search Task dialog box appears. 

2 Enter the appropriate information in the Search Task dialog box, and then click 
Search.  

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 Perform one of the following steps: 

 If you performed a search for an announcement property, perform one of the 
following steps: 

 If you want to move an announcement property, right-click the announcement 
property, and then choose Move from the popup menu. 

 If you want to edit an announcement property, right-click the announcement 
property, and then choose Edit from the popup menu. 
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 If you want to rename an announcement property, right-click the announcement 
property, and then choose Rename from the popup menu. 

 If you want to delete an announcement property, right-click the announcement 
property, and then choose Delete from the popup menu. 

 If you want to view how the announcement properties will be printed, click 
PrintPreview. 

 If you want to print the announcement properties, click Print. 

 If you performed a search for an audio file, perform one of the following steps: 

 If you want to move an audio file, right-click the audio file, and then choose 
Move from the popup menu. 

 If you want to copy an audio file, right-click the audio file, and then choose 
Copy from the popup menu. 

 If you want to rename an audio file, right-click the audio file, and then choose 
Rename from the popup menu. 

 If you want to delete an audio file, right-click the audio file, and then choose 
Delete from the popup menu. 

 If you want to view how the audio files will be printed, click PrintPreview. 

 If you want to print the audio files, click Print. 

2 When you are finished, click Cancel.  

 

Search Results for groups dialog box 

This dialog box displays the results of your search for a VAL source. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

 Right-click the voice system in the Voice Announcement Manager tree, choose 
Search/Replace VAL Sources in Group from the popup menu, and search for a VAL 
source. 

 Select the voice system in the Voice Announcement Manager tree, choose 
Search/Replace VAL Sources in Group from the Actions menu, and search for a 
VAL source. 

How do I use this dialog box? 

To print the information displayed in the Search Results for group dialog box, click Print. 
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Search Task dialog box 

This dialog box lets you search for  

 announcement property files on a voice system 

 audio files on a voice system 

You can specify to search all of your voice systems. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

 Right-click Voice Systems in the Voice Announcement Manager tree, and then choose 
Search Announcement Property/File from the popup menu. 

 Select Voice Systems in the Voice Announcement Manager tree, and then choose 
Search Announcement Property/File from the System menu. 

 Right-click a voice system in the Voice Announcement Manager tree, and then choose 
Search Announcement Property/File from the popup menu. 

 Select a voice system in the Voice Announcement Manager tree, and then choose 
Search Announcement Property/File from the System menu. 

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 Perform one of the following steps: 

 If you want to search for an announcement property file: 

a. From the Voice System box, select the voice system you want to search. If 
you want to search all of the voice systems, select All Voice Systems. 

b. From the Announcement box, select Property. 

c. From the Property Name box, select the first search criterion you want to 
use.  

d. From the next box, specify how you want to perform the search. Choices are 
equals, contains, starts with, and ends with.  

e. In the Value box, enter the information you want to find.  

f. If you want to use a second search criterion, perform the following steps: 

a. From the next box, select whether the second search criterion is 
required. Select either AND or OR. If you select NONE, the second 
search criterion will not be used. 

b. From the next Property Name box, select the second search criterion 
you want to use. 

c. From the next box, specify how you want to perform the search. Choices 
are equals, contains, starts with, and ends with. 

d. From the next Value box, enter the information you want to find. 

 If you want to search for an audio file: 

a. From the Voice System box, select the voice system you want to search. If 
you want to search all of the voice systems, select All Voice Systems. 

b. From the Announcement box, select File. 

c. From the box, specify how you want to perform the search. Choices are 
equals, contains, starts with, and ends with.  
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d. In the Value box, enter the information you want to find.  

2 Click Search. 

 Voice Announcement Manager displays a status box that shows the status of the 
search.  

 When the search is completed, the Search Result dialog box appears. 

3 Click OK. 

 The files that match your search criteria are displayed. 
 

Select Frequency dialog box 

This dialog box lets you specify the following settings for a task: 

 the date and time the task will start  

 the frequency the task will be performed (that is, once, frequent, daily, weekly, and 
monthly) 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by performing the following 
steps:  

1 From the Actions menu, choose Scheduler. 

 The Task Editor dialog box appears. 

2 Click Add.  

 The Create Task dialog box appears. 

3 Click the Create New Task option button, and click OK.  

4 Complete the task-related dialog boxes.  

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 From the Date box, select the date when you want this task to be performed. 

2 In the Time area, enter the time when you want this task to be performed.  

3 In the Frequency area, click the appropriate option button to specify how often you 
want this task to be performed.  

4 Click one of the following: 

 Finish to complete the task and close the dialog box. 

 Next displays the next dialog box. 

 Back displays the previous dialog box. 

 Cancel to ignore the information and close the dialog box. 

 Help for assistance understanding this dialog box. 
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Select VAL Boards to be backed up dialog box 

This dialog box lets you select the VAL/virtual VAL boards you want to back up via a task. 
You can select VAL boards from different voice systems. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by performing the following 
steps: 

1 From the Actions menu, choose Scheduler. 

 The Task Editor dialog box appears. 

2 Click Add.  

 The Create Task dialog box appears. 

3 Click the Create New Task option button, and click OK.  

 The Create New Task dialog box appears. 

4 Enter the appropriate information.  

5 Click the Backup option button, click the Backup Selected VAL Boards option 
button, and then click Next.  

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 In the Administered VAL Boards box, select the VAL/virtual VAL boards you want to 
back up, and click the > button. If you want to select all of the boards for a voice 
system, select the voice system, and then click the > button. If you want to select all 
of boards for all of the voice systems, click the >> button. 

The boards you selected appear in the Selected VAL Boards to Backup box. 

If you make a mistake, highlight the mistake in the right box and click the < button, or 
click Cancel to start over. 

2 Click one of the following: 

 Next to access the Select Frequency dialog box. 

 Back displays the previous dialog box. 

 Cancel to ignore the information and close the dialog box. 

 Help for assistance understanding this dialog box. 
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Select VAL Boards/Groups To Be Restored dialog box 

This dialog box lets you restore your announcements to VAL/virtual VAL boards or 
groups on a voice system you select. 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

 Right-click a voice system in the Voice Announcement Manager tree, and then choose 
Restore from the popup menu. 

 Select a voice system in the Voice Announcement Manager tree, and then choose 
Restore from the Actions menu. 

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 At the top of the Administered VAL Boards box, be sure the correct voice system is 
displayed. 

 If it is not, click Cancel and start over, being sure to select the correct voice system 
first. 

2 In the Administered VAL Boards box, highlight the VAL/virtual VAL boards that you 
want to restore and click the > button. If you want to restore all of the boards, either 
click the >> button or select the voice system and click the > button. 

The files you select appear in the Selected VAL Boards to Restore box. 

If you make a mistake, highlight the mistake in the right box and click the < button, or 
click Cancel to start over. 

3 Repeat Step 2 until you have specified all of the boards that you want to restore. 

4 If you want the restore files to override the protected bit, select the Override 
Protected Bit check box. 

5 If you use the same file in multiple VAL sources, select the Use file from first 
available source directory check box. Voice Announcement Manager will use the 
file from the first available source directory to restore all members. This option 
reduces the time to restore files to all members.  

6 Click one of the following: 

 OK to execute the restore and close the dialog box 

 Apply to execute the restore and leave the dialog box open. 

 Cancel to abort the restore and close the dialog box. 

 Help for assistance understanding this dialog box. 
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Task Editor dialog box 

This dialog box lets you 

 create tasks that you can schedule to run at a specified date, time, and frequency  

 modify tasks that you created 

 delete tasks that you created 

 stop a task from being performed  

You can create tasks to perform the following actions: 

 back up selected VAL boards  

 back up all voice systems 

 broadcast announcements 

 import voice announcement properties from a comma-separated values (CSV) file and 
send that data to a voice system 

 export voice announcement properties from a voice system to a comma-separated 
values (CSV) file 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by choosing Scheduler 
from the Actions menu 

How do I use this dialog box? 

This dialog box displays the following information for each task: 

 Id (which is assigned to the task automatically by the Scheduler) 

 name (which you created for the task) 

 type (that is, backup task, backup all task, broadcast task, import task, or export task) 

 the next time this task will be performed 

 the last time this task was performed  

 the current status. The possible status states are: 

 Pending: The task will be performed in the future. 

 Running: The task is currently running. 

 Completed without errors: The task was performed successfully and will not run 
in the future. 

 Completed with errors: The task was performed with errors and will not run in the 
future. 

 Aborted: The task was aborted and will not be performed unless it is modified. 

 the frequency of this task  

To use this dialog box, perform any of the following steps: 

 If you want to create a new task, click Add.  

 If you want to modify an existing task, select the task, and click Modify. 

 If you want to delete a task, select the task, and click Delete. 

 If you want to stop a task, select the task, and click Abort  

 If you want to clear all completed tasks, and click Clear.  
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 If you want to access the Template Editor dialog box, click View.  

 If you want to close this dialog box, click Close.  
 

Template Editor dialog box 

This dialog box lets you 

 create new templates  

 modify existing templates 

 delete templates 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it by choosing Template 
Editor from the Actions menu. 

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 Perform any of the following steps: 

 If you want to create a new template, click Add. 

 If you want to view the contents of a template, select the template in the Templates 
box. The contents of the selected template are displayed in the Task Summary box. 

 If you want to modify an existing template, select the template in the Templates box, 
and then click Edit. 

 If you want to delete a template, select the template in the Templates box, and then 
click Delete. 

2 Click one of the following: 

 Cancel to close the dialog box. 

 Help for assistance understanding this dialog box. 
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View Audio File Properties dialog box 

This dialog box lets you view and print the properties for the audio files on the VAL/virtual 
VAL board you select. From this dialog box, you can also rename the audio file. 

For each audio file, the following information is displayed: 

 name 

 size 

 length (in seconds) 

 time stamp  

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

 Right-click a VAL/virtual VAL board in the Voice Announcement Manager tree, and then 
choose View/Rename Audio Files Properties from the popup menu. 

 Select a VAL/virtual VAL board in the Voice Announcement Manager tree, and then 
choose View Audio Files Properties from the View menu. 

 Select a VAL/virtual VAL board in the Voice Announcement Manager tree, and then 
choose View/Rename Audio Files from the Actions menu. 

How do I use this dialog box? 

This dialog box displays the properties for each audio file on the selected VAL/virtual VAL 
board. Perform any of the following: 

 To rename the audio file: 

1 Highlight the file you want to rename, and click Rename. 

 The Rename Audio File dialog box appears. 

2 Complete the Rename dialog box, and then click OK. 

 To preview how the audio file properties will appear when printed, click Print Preview. 

 To print the audio file properties, click Print. 

 To close the dialog box, click Close. 

 To get assistance understanding this dialog box, click Help. 
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Virtual VAL Boards Status dialog box 

This dialog box lets you  

 view the status of all the virtual VAL boards on a voice system 

 change the status of a virtual VAL board 

How can I view this dialog box? 

If you aren’t viewing this dialog box already, you can access it in any of the following 
ways: 

 Right-click a voice system in the Voice Announcement Manager tree, and then choose 
View Virtual VAL Board Status from the popup menu. 

 Select a voice system in the Voice Announcement Manager tree, and then choose View 
Virtual VAL Board Status from the View menu. 

How do I use this dialog box? 

To use this dialog box, complete the following steps: 

1 Perform one of the following steps: 

 If you want to enable a virtual VAL board, click on the Status cell for the board, and 
select Enabled. 

 If you want to disable a virtual VAL board, click on the Status cell for the board, and 
select Disabled. 

2 Click one of the following: 

 Update to change the status for the virtual VAL board. 

 Cancel to close the dialog box. 

 Help for assistance understanding this dialog box. 
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Contacting Us 

General Contact Information 

 

 For Contact 

 Avaya’s Home Page www.avaya.com  

 Avaya products www.avaya.com 
click Solutions, Products & Services 

 Online product catalog www.avaya.com  
Then click How to Buy. 

 Security systems http://wwwdb.avaya.com/pls/bcs/syst.main?p_id=8
5&p_keyword=  

 International Alliance of Avaya 
Users (InAAU) 

www.inaau.org  

 

Technical Support 

Before you call, prepare the information that the helpline needs. 

For customers located in the US: 

For help with… Contact this resource: Contact Information 
 

Voice 
Announcement 
Manager 

Avaya’s National 
Customer Care Center  

1 800 242 2121 

Avaya 
Communication 
Manager software 
features and 
administration 

Voice System Helpline of 
Avaya 

1 800 225 7585 

Avaya 
Communication 
Manager software 
maintenance and 
repair 

Avaya’s National 
Customer Care Center  

1 800 242 2121 

Voice mail systems Avaya National Customer 
Care Center 

1 800 242 2121 

Toll fraud Avaya’s National 
Customer Care Center  
(Toll Fraud Helpline) 

1 800 643 2353 

web-based 
technical support 

Avaya’s Customer 
Support web site 

http://www.avaya.com  
Then click Support 

For customers located outside the US 

Contact your local distributor or Avaya representative. 

http://www.lucentdirect.com
http://wwwdb.lucent.com/bcs/solutions.main?p_id=14&p_keyword=
http://www.lucent.com/enterprise
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Contacting us for documentation 
To… Use this resource: Contact Information 

 

View 
documentation 
online 

Recent documents http://www.avaya.com  
Then click Support. 
Then click Product Documentation. 

Order 
documentation 
by mail 

Globalware Solutions Globalware Solutions 
200 Ward Hill Avenue 
Haverhill, MA  01835  USA 
USA 

Order 
documentation 
by  
phone or fax 

Avaya Publications 
Center 

1 800 457-1235 (phone) 
1 800 457-1764 (fax) 

If you are calling from somewhere 
that can not access US 1-800 
numbers, then call: 

+1 410 568 3680 (phone) 
+1 410 891 0207 (fax) 

Contacting us about training 

For customers located in the US: 

To… Use this resource: Contact Information 
 

Ask general training 
questions 

Avaya University 
HelpDesk 

1 800 288 5327 
6:00 a.m. to 5:00 p.m. 
Mountain Standard Time 

Search an online catalog of 
classes, videotapes, and 
computer-based training 

Avaya training web 
site 

http://learning2.avaya.com/  

Register for classes Avaya University 
Registration Center 

1 800 255 8988 

Order videotapes and 
computer-based training 

Avaya Direct www.avaya.com/direct  

For customers located outside the US: 

Contact your local distributor or Avaya representative. 

http://support.lucent.com/cgi-bin/gx.cgi/AppLogic+Elmo#ELMO
http://www.lucent.com/enterprise/training
http://www.lucentdirect.com
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Giving us your feedback 
To…  Contact… 

 

Ask questions not 
answered in the help 

by phone Technical Support  

Offer comments on the 
online help 

by email DO NOT SEND PRODUCT OR 
TECHNICAL QUESTIONS TO THIS 
EMAIL ADDRESS. SEND ONLY 
QUESTIONS ABOUT PRODUCT 
DOCUMENTATION: 
document@avaya.com Subject line: 
Voice Announcement Manager Help 
Topic "<Name of topic>" feedback. 

 by fax + 1 732 852 2469 

Attention: Voice Announcement 
Manager Documentation 

 by mail Voice Announcement Manager 
Documentation Team 
Room 3C-313 
307 Middletown Lincroft Road 
Lincroft, NJ  07738-1526 
USA 

Share information with 
other Avaya product 
users 

over the 
web 

www.inaau.org 
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